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CHAPTER

1

Installation

The Visual TCAD device simulation software works on both Windows and Linux
platform. In the following sections, we shall outline the installation procedures
on both platform, and the procedure to start the graphical user interface and the
command-line interface.

Installing on Windows

Genius Device Simulator

The installation package comes as an executable file. Double clicking on it will
start the installation wizard (Figure 1.1, p. 1).

Genius TCAD Setup E\

Welcome to the Installlammer Wizard for Genius
! TCAD

This will install Genius TCAD version 1.0 on your compuker,

It is recommended that vou close all other applications
before continuing.

Click Mext to continue or Cancel to exit Setup,

Mext = || [ Cancel

Figure 1.1 Welcome message.

We recommend install Paraview, a versatile visualization software package, to
examine the output file generated by Genius. The installer of Paraview is included,
and the user can choose to install it.

After installation, we can test the installation with the bundled examples. Please
click Startl> All Programs > Cogenda Genius TCAD > VisualTCAD to start the Simulation
manager, and follow the tutorial in Chapter 2, “Tutorials”, p. 15.
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Genius TCAD Setup

License Agreement “

Please read the following license agresment carefully,

EMD USER LICENSE AGREEMENT b’

IMPORTANT! Do not install this SOFTWARE before you have read this license agreement. By
proceeding to install this SOFTWARE you are indicating your acceptance of all the terms and
conditions stated in this agreement.

This is & legal agreement between waou (either as an individual or a single entity) and Cogenda
Pte Ltd For this software product which includes computer software and may incude associated
media, prinked materials, and "online” or electranic documentation (the "SOFTWARE"), By
installing, copying of otherwise using this SOFTWARE you are agreeing ko be bound by the
terms of this agreement, IF vou do not agree to the terms of this Agreement, do not install or
use the SOFTWARE and if it is & non-evaluation wersion, return it tagether with physical
materials and media ko the place you obtained them for a Full refund.

£

(%1 accept the kerms of the license agreen

(1 do not accept the terms of the license agreement.

< Back ] [ Ves ] [ Mo

Figure 1.2 License agreement.

Genius TCAD Setup

Choose Destination Location “

‘where should Genius TCAD be installed?

Setup will install Genius TCAD in the Following Folder.

Toinstall to this Folder, click Next, Toinstall to a different folder, click Browse and select anather
folder.

Destination Folder

Z:\Program FilesiCogenda

[ < Back. ] [ Nexts | [ Cancel I

Figure 1.3 Choosing target installation directory.

Genius TCAD Setup

Installing “

Instaling Genius TCAD

Flease wait while Setup installs Genius TCAD on your computer,

Installing Program Files, .,

[ J

Cancel

Figure 1.4 Copying files.
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Genius TCAD Setup E‘

Genius TCAD Recommended Software

It is recommended ko use the Paraview Soientific
wisualization pragram ta view the solution generated by
Genius TCAD simulator,

Would you like ko install Paraview?

Install Paraview

< Back ] ‘ et = | [ Cancel

Figure 1.5 Optional software packages.

Genius TCAD Setup E‘

InstallJammer Wizard Complete

The Installdammer Wizard has successfully installed Genius
TCAD.  Click Finish to exit the wizard,

Figure 1.6 Installation completed.
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Installing on Linux

Installing on Linux

Installing

The installation package of the Linux version is a self-extracting program, typi-
cally named as Cogenda-Linux-<version>.bin. The same package includes
binaries and data files for several Linux platforms, include Redhat Enterprise
Linux release 5 and release 6, 32- and 64-bit platforms.

Typically we will run the installer as a super user (root):

$ su
$ ./Cogenda-Linux-1.7.4.bin

The installer will check the operating system and the prerequisite software needed
to run VisualTCAD. If the operating system is recognized, it lists the editions
suitable on this platform in the following menu, along with the features contained
in each edition.

Checking the machine architecture: found rhelb5-64
Editions recommended on this machine:

VisualTCAD-flexlm-1.7.4-1-rhel5-64

Platform: rhel5-64 Features: Floatinglicense
VisualTCAD-full-flexlm-1.7.4-1-rhel5-64
Platform: rhelb5-64 Features: Full,Floatinglicense

VisualTCAD-full-ib-flexlm-1.7.4-1-rhel5-64
Platform: rhel5-64 Features: Full,InfiniBand,Floatinglicense

The user may choose from the menu the edition to be installed. The basic edition
[1] is suitable for most users. The full edition [2] contains advanced products such
as VisualFab and VisualParticle that requires special licenses. The ib edition [3]
only runs on cluster computers with Infiniband interconnect hardware. The user
may also enter O to see a full list of editions included in the package.

If the operating system is not recognized, all editions will be displayed, and the
user may choose one that matches his platform most closely.

The installer then prompts the user to input the target installation directory, the
default location is /opt/cogenda.

Genius Device Simulator
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The end user license agreement will be displayed, and one must enter y to accept
it. It then prints out a summary of this installation, and asks the user to confirm.

Installation Summary

Install to : /opt/cogenda
Platform : rhelb-64
Features : Full,Floatinglicense

Is the above correct? [Y/exit]

The installer proceeds to unpack the executable binaries and data files. Finally, it

asks the user if a shortcut link is to be created to point to the installed version of the
software. If one accepts the default setting, a soft-link named /opt/cogenda/current
will be created.

Make a link to the installed version? [Y/n]
Enter a name for the installed version [current]

After installation, a typical directory structure would look like the following.

/opt/
|- cogenda/
|- current -> releases/VisualTCAD-flexlm-1.7.4-1-rhelb-64
|
|- previous -> releases/VisualTCAD-flexlm-1.7.4-rhel5-64
|
| - documents/
I |- 1.7.4/
|- ...
+- 1.7.4-1/
|-

releases/

I

I

|

|

|-

| |- VisualTCAD-flexlm-1.7.4-rhel5-64
| +- VisualTCAD-flexlm-1.7.4-1-rhelb5-64
I
|-
I

I

Genius Device Simulator 5
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Installing the Floating License on Linux

FlexLM provides floating license, and enable computers in the same network to
share the same license on the license server. When Cogenda software runs on other
machines, they obtain the license from node00 via network. This documents de-
scribes how to work with the license manager program, assuming that the license
server runs on the computer node00, and that Cogenda software are installed in a
shared directory /opt/cogenda. It is also assumed that users’ home directories
are shared among all hosts with NFS or other distributed file system.

Starting FlexLM Server

Copy the cogendal.lic file to /opt/cogenda/cogenda.lic. The content of the
file looks something like the following

SERVER node0OO any
VENDOR COGENDA
USE_SERVER

FEATURE VTCAD COGENDA 1.000 31-mar-2012 4 SN=Customerxxx SIGN="..."

FEATURE VFAB COGENDA 1.000 31-mar-2012 4 SN=Customerxxx SIGN="..."

FEATURE VPTKL COGENDA 1.000 31-mar-2012 4 SN=Customerxxx SIGN="..."

FEATURE GENIUS_MISC COGENDA 1.000 31-mar-2012 100 SN=Customerxxx SIGN="..."
FEATURE GENIUS_COMMON COGENDA 1.000 31-mar-2012 32 SN=Customerxxx SIGN="..."
FEATURE GENIUS_DDM2 COGENDA 1.000 31-mar-2012 32 SN=Customerxxx SIGN="..."
FEATURE GENIUS_EBM3 COGENDA 1.000 31-mar-2012 32 SN=Customerxxx SIGN="..."
FEATURE GENIUS_AC COGENDA 1.000 31-mar-2012 32 SN=Customerxxx SIGN="..."
FEATURE GENIUS_SPICE COGENDA 1.000 31-mar-2012 32 SN=Customerxxx SIGN="..."
FEATURE GENIUS_OPTICAL COGENDA 1.000 31-mar-2012 32 SN=Customerxxx SIGN="..."
FEATURE GENIUS_HIDDM1 COGENDA 1.000 31-mar-2012 32 SN=Customerxxx SIGN="..."
FEATURE GDS2MESH COGENDA 1.000 31-mar-2012 32 SN=Customerxxx SIGN="..."
FEATURE GSEAT COGENDA 1.000 31-mar-2012 32 SN=Customerxxx SIGN="..."

Each line corresponds to a feature. This file shows a license with all features
enabled, with 32-way parallel computation enabled in the Genius simulator.

One first enter the Cogenda environment with the command below.

$ source /opt/cogenda/1.7.3/bin/setenv.sh

One then starts the license server with the following command on node00. It is
not necessary to use root privilege.

$ lmgrd -c /opt/cogenda/cogenda.lic -1 /tmp/flexlm.log
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The 1mgrd command starts the FlexLLM server, read in the license file, saves the
log messages to /tmp/flexlm.log, and turned to background running. If the
server is correctly started, the end of £1ex1m. log file should contain the follow-
ings.

(Imgrd) License file(s): /opt/cogenda/cogenda.lic

(lmgrd) 1lmgrd tcp-port 27000

(Imgrd) Starting vendor daemons ...

(1mgrd) Started COGENDA (internet tcp_port 48793 pid 19111)

(COGENDA)
(COGENDA)
(COGENDA)
(COGENDA)
(COGENDA)
(COGENDA)
(COGENDA)

FLEXnet Licensing version v11.10.0.0 build 95001 x64_1sb
Server started on localhost for: VTCAD

VFAB VPTKL GENIUS_MISC

GENIUS_COMMON GENIUS_DDM2 GENIUS_EBM3

GENIUS_AC GENIUS_SPICE GENIUS_OPTICAL

GENIUS_HIDDM1 GDS2MESH GSEAT

EXTERNAL FILTERS are OFF

(1lmgrd) COGENDA using TCP-port 48793

The license server is running on TCP port 27000 of node00.

Verifying the FlexLM Server

Usually Cogenda software will automatically find the license server running on the
local network, but it is advised to explicitly configure the location of the license
server. One creates a config file .flexlmrc under his/her home directory, i.e.
$HOME/ . flex1lmrc. The content of the file would be

COGENDA_LICENSE_FILE=@node00

$ lmstat
lmstat - Copyright (c) 1989-2011 Flexera Software, Inc. All Rights Reserved.
Flexible License Manager status on Thu 1/5/2012 14:17

One can use the 1Imstat command to verify if one can successfully query the
license server. For example, one can run the command on node03, and expect
the following output:

License server status: 27000@node00
License file(s) on hydrogen: /opt/cogenda/cogenda.lic:

node00: license server UP (MASTER) v11.10

Genius Device Simulator
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Vendor daemon status (on hydrogen):

COGENDA: UP v11.10

Finally, one can use the 1mdown command.

Merging with other licenses managed by FlexLM

If one is using FlexLLM licenses issued by other vendor as well as that from Co-
genda, he/she can manage them with a single instance of FlexLM server.

To do this, one needs to copy all "Vendor Daemons" from all vendors, along with
the 1lmgrd program, to the same directory, i.e. /opt/flexlm/bin. Cogenda’s
vendor daemon is located at /opt/cogenda/1.7.3/bin/COGENDA.

One then copies all the license files to /opt/flexlm/license/, and starts the
flexIm server with the command.

$ /opt/flexlm/bin/lmgrd -1 /tmp/flexlm.log \
-c /opt/flexlm/license/cogenda.lic:/opt/flexlm/license/synopsys.lic

Note how license files from various vendors are concatenated with semicolon in
the —c option.

8 Genius Device Simulator
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Using the Graphical Interface

VisualTCAD is the integrated graphical user interface of the Genius device sim-
ulation package.

To start Visual TCAD in Windows, please click Startt> All Programs > Cogenda Genius TCAD B>
VisualTCAD in the Start Menus.

In Linux, one types the following command in a shell.

$ /opt/cogenda/1.7.2/VisualTCAD/bin/VisualTCAD &

The main window of VisualTCAD is shown in Figure 1.7, p. 9.

Visual TCAD

Project Explorer
e —
0

Figure 1.7 The VisualTCAD Main Window

Checking To check the license status, click in the menu Helpt>License. The license status
License Status  dialog shown in Figure 1.8, p. 10. If you download the trial version of Genius
from the website, the default license file included in the package is valid for one
month only. Some advanced features and disabled and at most 2 processors are
supported. You need to register your copy with Cogenda in order to continue using
Genius. To register, click the register button, and email the generated registration

code to Cogenda or a sales representative.

Genius Device Simulator 9
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Using the Graphical Interface

C VisualTCAD.LINUX x

License location |fhome/hash/build/genius/license/lic.dat
License status | ok
Time to expire {days) | 327

Enabled processors | 4

Enabled features |Feature Available

POISSCN
DDM1
DDM2
EBM3

AC
RAYTRACE
EMFEM2D

Refresh Register

Figure 1.8 The License Status Dialog

Every release bears a unique version string, which should be quoted when re-
questing technical support from Cogenda. The version number of the release can
be checked by clicking the menu Help > About, and the version number is shown in

the dialog Figure 1.9, p. 10.

Version: 1.6.0-beta-6-gf4b1900 (#f4b1300)
Date: Feb 6 2010

Copyright (C) 2008-2010 by Cogenda EDA
http:ffwww.cogenda.com

Figure 1.9 The About Dialog

Genius Device Simulator
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Using the Command-line Interface

Configuration

Running with
one CPU

This section outlines the command-line usage of Genius under Linux. A similar
command-line interface exists under Windows, but is rarely used.

After the installation, one may want to test the installation with the following steps.
Daily usage can be (and usually should be) performed under a normal user account,

instead of using the root account.

We first copy the examples to our home directory:

$ cp -r /opt/cogenda/genius/examples $HOME/genius_examples
$ cd $HOME/genius_examples/PN_Diode/2D

For convenience, we add the installation directory to his PATH environment for
his convenience. With the bash shell one can type

$ export PATH=$PATH:/opt/cogenda/genius/bin

or with csh

# set PATH=$PATH:/opt/cogenda/genius/bin

Now we try running the PN diode example with one single processor:

$ genius -n 4 -i pn2d.inp

The running log will be output to screen. It is pretty long, we show only the
beginning and ending portions here:

>k 5k 3k >k 5k >k >k 5k >k >k 5k %k 5k 3k >k 5k 5k >k 5k >k >k 5k %k 5k 3k >k 5k >k >k 5k >k 5k 3k >k >k >k >k >k >k >k >k %k >k 3k >k >k >k >k >k >k >k >k >k >k >k >k >k >k >k >k >k >k >k %k >k %k %k >k %k > %k *k >k

*
*
*
*
*
*
*
*
*

Genius Device Simulator

8
8
8

Parallel Three-Dimensional General Purpose Semiconductor Simulator

8

8

888888

8888

888888

8

8

88888888 88 888 88888 888 888 8888888 *
8 8 8 8 8 8 8 8 *
8 8 8 8 8 8 8 8 *
88888888 8 8 8 8 8 8 888888 *
8 8 8 8 8 8 8 8 *
8 8 8 8 8 8 8 8 *
88888888 888 88 88888 8888888 8888888 *

*

*
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* *
* This is Genius Commercial Version 1.7.2 with double precision. *

* *
* Copyright (C) 2008-2011 by Cogenda Company. *

sk sk sk sk o ok sk o o ok ok sk sk sk sk sk sk sk ok o o ko ok sk sk sk sk sk sk sk ok o ks sk sk sk sk sk sk sk sk sk ok ok ko sk sk sk sk sk sk sk sk sk ok sk ok sk sk sk sk sk sk sk sk ok ok
Constructing Simulation System...

External Temperature = 3.000000e+02K
Setting each voltage and current source here...done.

DC Scan: V(Anode) = 2.000000e+00 V

its | EQCV) | | Eq(@) | | Eq(p) | | Eq(T) | |Eq(Tn)| |Eq(Tp)| Idelta x|
0 3.69e-03 4.42e-05 5.79e-05 0.00e+00 0.00e+00 0.00e+00 0.00e+00
1 7.67e-11 3.89e-06 3.07e-06 0.00e+00 0.00e+00 0.00e+00 4.93e-02
2 7.98e-15 3.44e-07 3.55e-07 0.00e+00 0.00e+00 0.00e+00 2.87e-03
3 2.57e-15 3.47e-08 3.52e-08 0.00e+00 0.00e+00 0.00e+00 2.87e-04
4 1.97e-15 4.09e-09 2.72e-09 0.00e+00 0.00e+00 0.00e+00 2.11e-05
5 1.92e-15 5.06e-10 1.68e-10 0.00e+00 0.00e+00 0.00e+00 1.09e-06

CONVERGED_PNORM_RELATIVE

Write System to XML VTIK file pn2d.vtu...
Write System to CGNS file pn2d.cgns...
Write Boundary Condition to file bc.inc...

Genius finished. Totol time is 1 min 2.78475 second. Good bye.

Running with  We can run Genius with more than one CPUs, using the -n option to specify the
Multiple CPUs  number of CPUs to utilize.

$ genius -n 2 -i pn2d.inp

Registering If you download the trial version of Genius from the website, the default license
file included in the package is valid for one month only. Some advanced features
and disabled and at most 2 processors are supported. You need to register your
copy with Cogenda in order to continue using Genius. To register, simply type

Genius Device Simulator
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$ genius -r

and a registration code will be displayed on screen.

stttk kokokokokokokokokook sk sk sk sk sk sk sk sk sk ok okokokok koo sk kokokokokoksk sk sk sk sk sk sk sk sk ok okokokokokok sk ko kokokokok sk sk ok ok ok ok ok ok
To register your copy, email the following registration code:
81e434677a0bb0501aabd85d07b9f621feb19babcabf24ff987e583fa083b48a771796178
ac1d9de40cc53£2980fd12de936febdcadb16e3b66b08e9e0bd314fc511£63cd2264b9abl
b10635ad3a515ec4£62e101d86206£d7694ae938210d0a406edabbecedb760£28£916c88d
d83010470068feb5afbcdf£8da09c4aed0d9d

Please email this registration code to Cogenda or its redistributors. You will be
given the license file 1ic.dat. Copy it to

/opt/cogenda/genius/license/lic.dat

and overwrite the old file. Genius now should work under registered mode, with
all options you subscribed turned on.

Command  The command line options for Genius are listed below:

Line Options
Name
genius -- Genius 3D parallel simulator
Synopsis
genius [ -n ncpus ] -i filename

genius -r

Options
-n ncpus Number of processors to be used in the simulation
-i filename  Input file to the simulator

-r Register the copy with Cogenda

Genius Device Simulator 13
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2

Tutorials

VisualTCAD is the integrated graphical user interface of the Genius device sim-
ulation package. This chapter provides a step-by-step tutorial to the VisualTCAD
graphical user interface.

Simulate a PN Junction Diode

Our first attempt is to simulate the forward I-V characteristics of a short-base PN
junction diode. The files of this tutorial are located at VisualTCAD/examples/tutorial/t

Building the Diode Structure

The first step is to construct the diode structure. Choose in the menu File> New

Device Drawing, which will start the 2D device drawing window, as shown in Fig-
ure 2.1, p. 15.

Visual TCAD BE

UHEnEm

®2HENEEE

EEEEE
BEEE

Layer List N
Object List \

Project Explorer
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Figure 2.1 The 2D Device Drawing Window
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Simple Mouse
Operations

Drawing
Device Outline

Simulate a PN Junction Diode

The coordinates of the mouse cursor is displayed in the status bar at the right-bot-
tom corner of the main window. The default unit of the coordinates is micron, but
this can be changed by the user.

To zoom-in or zoom-out the viewport, one can click the &+ Zoom-in or 4 Zoom-out
tool button. Alternatively, one could simple scroll the mouse wheel up or down.
The zooming will leave the view under the mouse cursor stationary.

To translate the viewport, one can hold the mid-button (wheel) of the mouse and
drag the viewport.

We start by drawing a box representing the body of the silicon diode. Choose from
the drawing tools || Add Rectangle .

We define the first corner of the rectangle by clicking at the coordinates (-1, 0).
One may notice that in the Add Rectangle tool, the mouse cursor is snapped to the
background grip.'Click again at (1, -2) to define the other corner, and complete
the rectangle. This closed rectangle region is slightly shaded.

We then proceed to define the anode and cathode by drawing the two rectangles
(-0.2,0.2)-(0.2,0) and (-1,-2)-(1,-2.2), respectively. The outline of the device struc-
ture is shown in Figure 2.2, p. 16.

Visual TCAD

Fle Edit View Drawing Device
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Figure 2.2 The Outline of the PN Junction Diode

1 . . . . . . .
The default snap mode is *%. Auto-Snap , which is appropriate in most occasions. The snapping modes

are described in detail in a separate documentation.
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Assigning
Material Regions

Placing Doping
Profiles

Genius Device Simulator

Every enclosed region in the drawing must be labelled and assigned a material.
To label such a region, one chooses the ITl Add Region Label tool, and click within
one of the regions. We first click at (0, -1), which prompts a dialog as shown in
Figure 2.3, p. 17. We key in the label Silicon, the maximum mesh size of 0.1
micron in this region, choose the Si material from the list, and click OK.

VisualTCAD

Region Label | Silicon h
Material | Si d
Symbol Color Select
Max. mesh size (um) | 0.1

Figure 2.3 Device Region Label Dialog

One notices that the region is now filled with the pink color representing the silicon
material. We similarly assign the Anode and Cathode regions, both of the A1
material, and the drawing becomes as in Figure 2.4, p. 17.
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Figure 2.4 The Regions of the PN Junction Diode

Doping is essential for semiconductor devices to function. To place a doping pro-
file to the device, one chooses the £ Add Doping Profile tool. A doping box consists
of a baseline and a height, and the available doping functions include uniform,
Gaussian and Erf. We first place the uniform body doping in the entire silicon
region.
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Simulate a PN Junction Diode

In the Doping Profile state, we click first at (-2,0) and t

hen at (2,0) to define the

baseline, and finally click at (2,-2) to define the height of the doping box. A menu
pops up and ask for the doping function, where we choose Uniform Doping Profile

in this case. A dialog pops up for us to key in the dopi

ng profile parameters, as

shown in Figure 2.5, p. 18. We shall name the profile body, and a n-type doping

concentration of 1 x 10'® ¢cm?.

Place Uniform Doping Profile x

Basic Parameters

Profile Name my J

Doping Species Donor -

Concentation (cm*~-3) | 1le+16

Profile Bound Rectangle

EBaseline Point 1 (-1 .o )
EBaseline Point 2 (|1 .o )
Height (um) 2

Orientation Left @ Right

Figure 2.5 Uniform Doping Profile Dialog

The p-type diffusion is then defined. We draw another doping box with baseline
(-0.2,0)-(0.2,0) and height to (0.2,-0.2). We choose the Gaussian doping function
and in the dialog shown in Figure 2.6, p. 18, we key in the peak concentration

1 x 10" cm?, and the characteristic length 0.1pm.

Place Gaussian Doping Profile x

Basic Parameters
Profile Name diffusion
Doping Species Acceptor |v

® Peak Concentration (em~-3) | 1le+19

Total Dose (cm~-2)

Characteristic Length
® Characteristic Length (um) | 0.1
Junction Depth (um)

XY Ratio 1

profile Bound Rectangle

Baseline Point 1 (|-02 .o )
Baseline Point 2 (|02 .o )
Height (um) 0.1

Orientation Left @ Right

Figure 2.6 Gaussian Doping Profile Dialog

The final doping profile of the diode is shown in Figure 2.7, p. 19. Note the
different color representing the n- and p-type doping profiles.
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Meshing

Genius Device Simulator
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Figure 2.7 The Doping Profiles of the PN Junction Diode

The numerical device simulation always relies on a mesh grid that divides the
device into many small elements. Click on the &l Do Mesh tool, and accepts the
default parameters in the mesh parameter dialog. The initial mesh is shown in
Figure 2.8, p. 19. One may notice that the PN junction is slightly highlighted

with shading.
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Figure 2.8 The Initial Mesh Grid of the PN Junction Diode
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Saving the Device

Simulate a PN Junction Diode

This initial mesh grid is not ideal for device simulation, as the junction region
would require finer mesh grids. One may use the % Mesh Refinement tool to refine
the initial mesh. Accepting the default refine parameters, one sees the mesh is
refined at the junction region, where the gradient of doping concentration is steep.
We do 2 refinements in sequence, and the final mesh is shown in Figure 2.9, p. 20.
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Figure 2.9 The Final Refined Mesh Grid of the PN Junction Diode

L
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We save the drawing with [ save, and key in the file name diode.drw. Addi-
tionally, we choose in the menu Device > Save Mesh to File to export the mesh grid to

diode.tif.
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Simulating the |-V Characteristics

Loading Device
Structure

Setting DC Sweep

Genius Device Simulator

We start by creating a new simulation control window by clicking in the menu
File > New Device Simulation. The empty simulation control window is shown in Fig-
ure 2.10, p. 21.

Visual TCAD
File Edit Simulation Window Help
D-FH amxbe HEe
Simulation Control & Device 2D: diode.drw.
simulation Control

Electrodes
Setup

Simulation Mode

FREE

[progress: overall | | step [ 14

Figure 2.10 The Device Simulation Control Window

We first load the diode device structure by clicking EF Load button in the Summary
section of the simulation control window. We select the diode.tif file we just
created. It takes a few seconds for VisualTCAD and Genius to analyse the tif file.
When it finishes, the device structure is visualized in the Structure Viewer, and
the automatically identified device electrodes are listed in the Electrodes section.
In this case we have the Anode and the Cathode.

One may notice that in the Simulation Control dock widget, the default Simula-
tion Mode is Steady-state, and the other choices are Transient and Cir-
cuit-element. There is also the list of regions and boundaries in the device
structure. Clicking on aregion or boundary name would highlight the correspond-
ing region or label in the Structure Viewer. The user can setup physical models,
boundary conditions and other solver options from the various tools in the dock
widget, but the options are too vast to be described here.

For this simple simulation of the I-V characteristics, it is sufficient to setup the
electrical sources attached to the electrodes of the device. While the cathode is
grounded, the anode voltage will be swept from O to 1 volt. We change the source
type of anode to Voltage Sweep, and set the start, stop and step voltages to 0,
1, and 0.05 volt, respectively.
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Figure 2.11 The Structure and Electrodes of the Simulated Device

We save the simulation setup to the file diode.sim. To start the simulation
job, click the ®™ Run and choose a working directory in the dialog shown in Fig-
ure 2.12, p. 22. We create a new directory called runi, and all the simulation
results will be kept in this directory.

i Choose working :'kirectnry x
Look in: [_¢,‘home,lhash,‘Documents,‘exampIesNTCAD ‘v] & = =

B corpy.. | | circut
- L@ pls-1
o hash Lu ple-2
L@ pl8-3
i pla-4
L@ pl8-5
L pla-6
L@ p18-7
i pla-s
L@ pl18-9

B run-1

Directory: I l il Choose
Files of type: I[Jirectones |'l ¥ Cancel
y

Figure 2.12 Choosing a Working Directory for the Simulation Run

As the simulation proceeds, the progress is updated in the status bar, at the right-bot-
tom corner of the window, as shown in Figure 2.13, p. 23. In addition, simulation
solutions are listed in the Results pane in the dock widget. For advanced users,
the running log message is available in the process monitor, which is activated by
clicking El console in the toolbar.
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Figure 2.13 The Device Simulation in Progress
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Examining the |-V Characteristics

Opening the
Spreadsheet

After the simulation completes, we wish to plot the I-V characteristics of this for-

24

Plotting the
I-V Curve

Setting Plot
Options

ward-biased PN junction diode. We can click the [F Show IV Data button to open
the spreadsheet containing the terminal information of the solutions. The spread-
sheet is shown in Figure 2.14, p. 24.
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Figure 2.14 Spreadsheet of the Simulated Terminal Characteristics

We first select the columns Anode_Vapp and Anode_current. Asin most GUI
applications, one can select multiple columns by clicking on the column header
and holding the Control key. When the two columns are selected, right-click to
activate the context menu, and choose to plot the data using as the Anode_Vapp
x-variable, as shown in Figure 2.14, p. 24. The plot appears in a new plot window,
as shown in Figure 2.15, p. 25.

To change the axes settings, click Edit Axes in the dock widget. In the axes property
dialog shown in Figure 2.16, p. 25, select the Left y-axis and key in the title,
scale and range of the axis.

To change the curve plotting settings, select the curve name from the list in the
dock widget, and click [=g| Edit Legend . In the dialog window shown in Figure 2.17,
p. 25, set the line and symbol options.

The final plot is shown in Figure 2.18, p. 26.
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Figure 2.15 Diode I-V Characteristics in Linear Scale
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Figure 2.18 Diode I-V Characteristics in Log Scale
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Visualizing the Solutions

Filter

Animation

Genius Device Simulator

We switch back to the Simulation Control window, and in the Result list, we select
all solutions. Right-click and in the context menu click Open Visualization™>. A new
visualization window is opened.

Suppose we want to plot the electron concentration profile in the device, choose in
the menu Draw > Draw Pseudo Color Electron density . In the visualization window, one
can hold the left mouse button and drag in the visualization window. Scrolling
the mouse wheel would zoom-in or -out the view, and dragging with the mid-
dle button (wheel button) would pan the view. As shown in Figure 2.19, p. 27,
the electron concentration is represented by the color scale. Check in the menu
Options B> Signed Log Scale to enable the log scale for the z axis.
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Figure 2.19 Electron Concentration in the Silicon Region of the Diode

One can filter the areas to be included or excluded in the visualization, in the Mesh
Filter section in the dock widget. We choose to filter by region names, as shown
in Figure 2.19, p. 27.

We have included all the solutions in the visualization, each solution at a different
anode voltage. The electron profile is different for each solution. In the Animation
Control section of the dock widget, we can step through the solutions by clicking
the &J Next and 3 Previous buttons.
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Visualization
View Options

Mesh Filter

Probe Variable

Animation Control
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Figure 2.20 Animation Control

Probe  We can probe the hole concentration along the straight line (0,0)-(0,-2) in the Probe
section in the dock widget, as shown in Figure 2.21, p. 28. After clicking the
Probe button, a spreadsheet containing the interpolated values of hole concen-
tration is opened. We can then plot the hole concentration along the cut-line, as
shown in Figure 2.22, p. 29.
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Figure 2.21 Probe Control
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Figure 2.22 Hole Concentration Along the Probe Line
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Summary

In the preceding sections, we went through the steps of simulating the I-V charac-
teristics of an PN junction diode. This illustrates the basic flow of device simula-
tion in VisualTCAD.
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Simulate a Diode Rectifier Circuit

We can combine the semiconductor device simulation with SPICE circuit simu-
lation. This section shows the steps to demonstrate the rectifying effect of the PN
diode. The files of this tutorial are located at VisualTCAD/examples/tutorial/tut2.

Assigning Circuit Symbol

We open the simulation file diode . sim again, and change the Simulation Mode
to Circuit-element. Since this is a two-terminal device, the default circuit
symbol with two pins is displayed, as shown in Figure 2.23, p. 31.
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Figure 2.23 Default Symbol for the Two-Terminal Device

We want a more suitable symbol for the diode, so we click Change Symbol, and
in the dialog (Figure 2.24, p. 32), we choose the diode symbol.

Then we must map the two device electrodes to the two pins in the circuit symbol,
as shown in Figure 2.25, p. 32. We save to another file named diode-circuit.sim
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Figure 2.25 Circuit Symbol for the Diode
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Drawing Circuit Schematic

We proceed to draw the circuit schematic. Click in the menu File > New Circuit Schematic

to open a new schematic capturing window. We first place the numerical device
component by clicking F Numerical Device in the dock widget. Selectdiode-circuit.sim
in the dialog. The diode symbol appears at the mouse cursor and can be placed to

the schematic with a click.
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Figure 2.26 Placing the Semiconductor Diode Device Model in the circuit

The other symbol components can be placed using 3 Component tool, the dialog
for selecting components is shown in Figure 2.27, p. 34. For common components
like resistors and capacitors, one can alternatively use the shortcut buttons in the
dock widget.

Finally one use the L wire tool to connect the components together. The com-
pleted circuit schematic is shown in Figure 2.28, p. 34.
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Figure 2.28 The Completed Rectifier Circuit Schematic
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Simulating the Circuit

Genius Device Simulator

We want to do transient mode simulation, so we setup the timing with the %3 Setup Simulation
tool, as shown in Figure 2.29, p. 35.
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Figure 2.29 Dialog for Setting Up Transient Analysis

We click the P Run Simulation tool to start the simulation. The monitoring and
analysis procedure is similar to that in the previous example. In the result spread-
sheet, we plot the columns probelpos and v1pos, using time as the x-variable.
The waveform plot is shown in the Figure 2.30, p. 35.
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Figure 2.30 The Voltage of the Sine Source and the Voltage Probe, as Functions of Time
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Summary

In this section, we outlined the procedure of simulating devices in circuit. This
integrated approach allows one to combine the accuracy of device simulation with
the power of SPICE circuit simulation.
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A 0.18um MOSFET

The files of this example are located at VisualTCAD/examples/MOSFET.

Building MOSFET Device Structure

Polyline Tool

Exact Coordinates
Input

Genius Device Simulator

As in the previous diode example, we shall start with drawing the device struc-
ture of the MOSFET transistor. We first draw the outline of the device with
the ] Add Rectangle and the ..~ Add Polyline tools, as shown in Figure 2.31, p. 37.

& O visual TCAD <@hydrogen>
Ele Edt View Drawing Device Window Help

ice Drawing ] Device 2D: p18.drw

Mouse: (0.4578,01752) Snap: (04578,01752)

Figure 2.31 Outline of a MOSFET transistor.

To draw a polyline or polygon, one can use the polyline tool. Single-click to add a
point to the line, double-click to add the last point of the line. If the first point and
the last point coincide, a polygon is formed. To cancel the unfinished polyline,
click the right mouse button.

In some cases, it is desirable to enter the exact coordinates of the points of a line.
For example, the thickness of the gate oxide of this MOSFET is 4nm, making it
difficult to locate the corners of the gate electrode using a mouse. Therefore, we
draw the electrode by keying in the exact coordinates.

We first enter the polyline tool. In the status bar, a coordinates input area appears,
as shown in Figure 2.32, p. 38. After one enters the x- and y-coordinates in
the blanks, and click the enter button, a point is added to the polyline. One can
similarly use this function in other drawing tools.
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Clone and Mirror

Labelling
Material Regions

A 0.18um MOSFET

[Input Coord.: ([0.0 |.[oo ]) [enter]|

Figure 2.32 Exact coordinates input area.

Some times one desire to make a copy of an object, or make a mirror image of
an object. For example, the side-wall spacers around the gate of the MOSFET
transistor are symmetrical, so one hope to draw one of them and make the other

by mirroring. The K’k Clone, Ak Mmirrorx and dlk MirrorY tools can help you on these
tasks.

One then label each region, assign a name and a material to it. Optionally, one can
set a mesh-size constraint to each region. The regions are shown in Figure 2.33,
p- 38, and the parameters for the regions are listed in Table 2.1, p. 38.

Region Material Mesh Size / pm
substrate Silicon 0.05

Source Al 0.04

Drain Al 0.04

Gate NPolySi 0.1

Substrate Al 0.05

spcl Nitride 0.1

spc2 Nitride 0.1

Table 2.1 Regions of the MOSFET transistor.

[ O Visual TcAD <@hydrogen> —
Fle Edt View Drawing Device Window Help

Layer List

Object List

Mouse: (-0.0368,01958) Snap: (-0.0368,01958)
P

Figure 2.33 Regions of the MOSFET transistor.
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Doping Profiles  One then define the doping profiles in the MOSFET. The position of the doping

Mesh Grid

Genius Device Simulator

boxes are shown in Figure 2.34, p. 39 and the doping profile parameters shown
in Table 2.2, p. 39.

Name Profile Type Peak Conc. / cm™  Char. L/ pm
Substrate uniform  Acceptor 5 x 10 -
Channel gaussian  Acceptor 1% 10'8 0.1
LDD_S/LDD_D  gaussian  Donor 2% 10" 0.02
Source/Drain gaussian ~ Donor 1 x 10%° 0.04

Table 2.2 Doping Profiles Parameters.

& O visual Tcap

Ele Edt View Drawing Device Window Help

LYE/ &

Explorer | Start | Device Drawin Device 20: p18.drw
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TS EE NN

Figure 2.34 Doping Profiles of the MOSFET transistor.

louse: (-0.2425,02105) Snap: (-02429,02105)

To make sure the mesh in the MOSFET channel region is fine enough, we use
the ™ Mesh size constrain tool to apply two constraints, shown in cyan color in Fig-
ure 2.35, p. 40. After two refinements, the final mesh is generated. We save the
mesh to a.tif file for further simulations.
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& O visual TcAD
file Edt View Drawing Device Window Help
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Figure 2.35 Final mesh grid of the MOSFET transistor.
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Simulating I-V Curves

Genius Device Simulator

As in the previous diode simulation, we create a device simulation and load the . tif
file containing the mesh grid of the MOSFET. As shown in Figure 2.36, p. 41,
we are in the steady-state simulation mode, the source and substrate terminals are
grounded. The drain terminal is connected to a constant voltage source of 0.1 V.
We shall sweep the gate terminal from 0 to 2 V to obtain the transfer characteris-
tics of the MOSFET.

& O Visual TCAD <@hydrogen>

U | I %

Simulation Control

Fle Edt Simulation Window Help
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[ 1G]

Simulation: idvg sm

Setup

Simulation Mode

Contact Name [ Source
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b Source Type
£ %
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Voltage

Contact Name

ConstVoltage |~

0 |V

Drain
ConstVoltage ||

01 v [

Substrate

Summary
Structure: |
saws. B

Solutions: (]

Structure Viewer

Embedded CGNS data

Ready to run.

' No solutions

EE)

%

Source Type [ConstVoltage |~
Voltage 0 |v_[2)

oxide to,
oxide to_spc2

oxide_to_substrate
substrate_Neumann

Contact Name [Gate
Source Type [Voltage Sweep |~
start vokage [0 v
Stop Voltage [2 Jv_[7)

Step Voltage 0,05 Jv_[+)

Results \

Progress Overall [ Step [

Figure 2.36 Simulation setup for calculating the 1d-Vg curve of the MOSFET.

We submit the simulation for running, and shall observe that the drain voltage is
first ramped up from 0 to0.1 V, before the actual gate voltage scan begins. This
drain ramp-up is necessary to ensure the convergence of the simulation.

After running the simulation, we obtain the spreadsheet containing the terminal
voltage/current information in the sweep. We plot the drain current against the

gate voltage, and obtain the Id-Vg curve shown in Figure 2.37, p. 42.

One can also visualize the electron concentration in the device, as shown in Fig-
ure 2.38, p. 42.

It might be interesting to click the ® Play tool-button to play the animation, and
watch the change of electron density as gate voltage increases.
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Figure 2.37 Simulated I1d-Vg curve of the MOSFET.
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Figure 2.38 Electron concentration at Vg=0.45V.

42 Genius Device Simulator



A 0.18um MOSFET

Tutorials

Setting Mobility Model Parameters
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So far we have always been using the default physical models and material para-
meters. In practice, we often need to modify these parameters to model certain
aspects of the real device more accurately. VisualTCAD allows you to modify
models and parameters in material regions and at boundaries.

For example, suppose we want to use the Lombardi mobility model, which de-
scribes the carrier mobility in the inversion layer more accurately. We click the
%5 Physical Model tool button, and in the material models tab of the physical model
dialog (Figure 2.39, p. 43), we select the substrate region. Since this is a semicon-
ductor region, we can choose the mobility model of it. We select the Lombardi
mobility model. From the user manual, we found the list of parameters for the
Lombardi model, which is reproduced here in Table 2.3, p. 43. We want to slightly
reduce the electron mobility, and set the MUN2 . LSM parameter to 1400.

© (O VisualTCAD <@hydrogen> ——— D ()
| Global Parameters | Physical Models | Material Models l
|Region |Materia| |Type Basic
Drain Al ~ Conductor regi 3and
Gate NPolySi Conducter regi
Substrate A Conductorrogy meact
gslcdle :ll!gije Insulator regior, Mobility
substrate |tr\de Model
Parameters | Name |Va|ue ]
MUNZ LSM 1400 5
i |
Optical
Thermal
[« [a]r] Trap
I

Figure 2.39 Setting mobility model and parameters.

Symbol  Parameter Unit Si:n Si:p
o EXN1.LSM/EXP1.LSM - 0.680 0.719
p EXN2.LSM/EXP2.LSM - 2.0 2.0

¢ EXN3.LSM/EXP3.LSM - 2.5 2.2

Table 2.3 Parameters of Lombardi mobility model
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A 0.18um MOSFET

Symbol  Parameter Unit Si:n Si:p

A EXN4.LSM/EXP4.LSM - 0.125 0.0317

¥ EXN8.LSM/EXP8.LSM - 2.0 2.0

Ho MUNO.LSM/MUPO.LSM  cm?V~ls7! 522 44.9

" MUN1.LSM/MUP1.LSM  cm?V's™! 434 29.0

thy MUN2.LSM/MUP2.LSM  cm?’V~'s™!  1417.0 470.5

P, PC.LSM cm™ 0 (fixed) 9.23 x 10
C, CRN.LSM/CRP.LSM cm™3 9.68 x 10'®  2.23x 10"
C, CSN.LSM/CSP.LSM cm™3 343%x 10 6.10 x 10%
B BN.LSM/BP.LSM cm/s 475%10"  9.93x10°
C CN.LSM/CP.LSM - 1.74%10°  8.84x10°
D DN.LSM/DP.LSM - 5.82x 10" 2.05x 10"
Vsato VSATNO / VSATPO cm/s 2.47 2.47

B BETAN / BETAP - 2.0 1.0

a VSATN.A/VSATP.A - 0.8 0.8

Table 2.4 Parameters of Lombardi mobility model

We can now run the simulation again, and observe the change to the 1d-Vg curve,
as a result of the change in the mobility model.
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Mix-Mode Simulation of Inverter 10 Circuit

As in the previous cmos simulation, we can create a device structure of inverter
and do Mix-Mode simulation. So we need draw a structure of inverter, the detail
step refer to mosfet structure building(“Building MOSFET Device Structure”,
p- 37), here we omit the drawing structure step. About this example we need draw
a inverter symbol, then use VisuaTCAD to do Mix-Mode simulation.

We can combine the semiconductor device simulation with SPICE circuit simu-
lation. This section shows the steps to demonstrate the output characteristic of In-

verter. The files of this tutorial are located at VisualTCAD/examples/Inverter.

Creating Symbol and Mapping Device Electrode

The first step is to draw the symbol of Inverter. Choose in the menu Filel> New
Circuit Schematic , then choose in the menu Place > Library Manager which will start the
Library drawing window, as shown in Figure 2.40, p. 45. Click the child window
|| Add Library,, input the Library name inverter, and last click to add symbol.

™ Visual TCAD
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+ Capacitance
:D“ ¢ 3 Inductance
T +
Current Probe
& | L wire [T o %
8 e
y
= =
o e [ | Type -]
(ol (ot 2
e Built-in library
(3] |mosasms | puittin fbrary
(@] [wumericoev... Built-in library
| |opamp-ns Built-in library
Probe Built-in library |
Component | ~Symbol
© 0l 8
Simulation Result | ;] =) 3 R
[Progress: Overall [ (@ ‘J Snap: (410, 520)

Genius Device Simulator

Figure 2.40 draw new symbol
Now we can obtain the child window of drawing symbol, as shown in Figure 2.41,

p. 46. First input the symbol name, then add the line or circles, in the process user
can using Enable/disabled grid snapping mode as needed.
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Figure 2.41 inverter symbol

When we finish the symbol drawing, we need add the pin of the symbol to con-
nect with other device of the circuit, here we need 4 pins, named PIN_VDD,
PIN_GND, PIN_IN, PIN_OUT, the pin name is must begin with PIN_. the draw-
ing process and is shown in Figure 2.42, p. 46.

B9 Eait symbol E] x

Name [inverter |

m [+] [ Attribute

‘1 Reference
@
(=) 1

Reference:

() ) (2] (2] (%] () [

PIN_VDD

PIN_IN 2

PIN_OUT

PIN_GND

[ X cancel

|

Figure 2.42 pin property

Last step for drawing the symbol is define the reference attribute. About the in-
verter device here we choose the value N, and it stands for Numerical Device.
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Which can use in Mix-Mode simulation. The child window is shown in Fig-

ure 2.43, p. 47.
W Edit Symbol 2%
Name [\HVEHEF
[ ; ] [a] Attribute
CJ
= 1
B
(c
€]
|3<] Reference=N |
(& l vEE L
&
|“=J 2 value[n | =] Numerical Device
L] oispay [ |+] "
size [10.00 2] PIN_VDD
Color - P
PIN_OUT
(o ] ! )
m CAS | FIN_GND
« K0 :

Figure 2.43 editing symbol attribute

Our 2D inverter structure is shown in Figure 2.44, p. 47. Here total have 8 elec-
trodes, we need connect each 2 electrodes like Figure 2.44, p. 47, finally we have
4 electrodes as our symbol of inverter.

Figure 2.44 2D inverter structure
before the interconnect, we need do boudary setting like Figure 2.45, p. 48
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v alx 1. Edit Workfunction
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PSub 2

Figure 2.45 boundary parameter setting

Aboout Numerical simulation, as shown in Figure 2.46, p. 48. We use intercon-
nect command to connect each 2 electrodes, such as connectting PSub to PSource,
connectting PGate to NGate, connectting PDrain to NDrain and connectting NSub
to NSource. It is shown in Figure 2.47, p. 49. At the same time we need define
the new electrode as VDD, IN, OUT and GND. it is shown in Figure 2.48, p. 49.
The new electrode OUT ia attached to current source so choosing Interconnect
Floating setting is true, as shown in Figure 2.49, p. 50.

& Visual TCAD

Fle Edit Simulation Window Help

= 5 & q = [Fle = =
U-od 9C = (52 VisuarTcap.Linux =IE3
Explorer | Start | Simulation Control | J
mtation Control {g)y Boundaries and Contacts Electrical | Thermal |
—_— Boundi Ty
Setup ey [Tipe Type [Ohmic contact I
NGate Gate contact Resistance 0 Q -
Simulation Mode  [Steady-state || | |NSource Ohmic contact ( e
NSub Ohmic contact Capacitance [0 Fol-
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Figure 2.46 boudary Condition and Interconnect

When we finish the boudary setting and interconnect setting, we need change the
Simulation Mode to Circuit Element, Since this is a four-terminal device, the de-
fault circuit symbol with four pins is displayed, as shown in Figure 2.50, p. 50.
We want a more suitable symbol for the inverter, so we click Change Symbol, we
change the symbol to we have edited before, as shown in Figure 2.51, p. 51.
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Figure 2.47 choose the contact to interconnect
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Figure 2.48 define new contact

Tutorials

Then we must map the four device electrodes to the four pins in the circuit symbol,
as shown in Figure 2.52, p. 51. We save to the file named inverter.sim.
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Figure 2.49 Interconnect Floating setting
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Figure 2.50 Change Simulation Mode

Genius Device Simulator



Mix-Mode Simulation of Inverter 10 Circuit Tutorials
¥ Visual TcaD DX
File Edit Simulation Window Help
- 3 & ol BT B
O-2H 9C |4 EI 0 & L 5'1
Simulation Control [~] i
~Symbol List Symbol Preview
Simulation Control B [ ——.— . -
umeric-Device |~
Setup N Circuit Symbol Lo
= BTN S Select library files to open
Mode | Circuit Element |~ BJT-P
Device
> o0 Device| Lookin: [F/Momefidm FeoeoomaE®
— g = PIN'] Device]
= Device m I_model & python 2
B4 4% < PIN_: Devicel odel 13 script | Inverterlib
Device| |9 home imodel18 script_yzl inverter2.lib
Devicel versemodel I sic
Device Structure Item Device| ver solar appli
Regions Change Symbol Device| Inverter sprocessexample
Boundaries Devicel verter_old subset
1 Device| aterial [E3 test_region_lable_clone
Devicel od_image tmp
Electrode fap Device| ole I3 training
: Device mos.13 VDMOS-doc
= [ symbolin | Devicel others | VDMOSGR
% PN_L Device| 13 |3 visualFab_Demo rar Folder
Device) 18 " bt Nlib
% FIN_2 Device 18_doping BJT_NPNViD
18vd2 ~ BJT_NPNVLIib
%/ PIN_3 pn_diode inverter_4lib
(3 PIN_4 [ [<[»
File name: [inverterlib ] | Qpen
Res AN Files of type: [Library file(*.lib) [+] [ % cancel |
[Progress-overany TSP T ] A
Figure 2.51 change symbol setting
%] Visual TcaD
File Edit Simulation Windew Help
- N [ o=
O~ ld 9C b a0 B
2 lation Control L[ [} simulation: *
. . &= [Electrodes [ Summary
Setu, N Srcuil
L s ovinbol structure: |~ Embedded CGNS data Feature swntches:
Simulation Mode | Gircuit Element ||
Status: » Ready to run.
(= %) T & —

£ % i

Device Structure Item
@ Regions
@ Boundaries

Results N\

(Change Symbol

Electrode Map 1

[ [ SpmbolPn JDevice Hechiode |
D

"
£3 |PIN_GND GND

Solutios

ns: (] g No solutions

[~ Structure Viewer

Progress.

- Overall [ | Step [

Figure 2.52 mapping setting
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Mixed-Mode Simulation

When we finfish the device setting, we need open a new circuit Schematic win-
dow and do circuit simulation, then choose %9 Numerical Device menu to draw our
inverter symbol and click - Component menu to draw Voltage source, we can click
corresponding menu to add Voltage Probe, Ground and Wire. The final circuit is
shown in Figure 2.53, p. 52.

GND

Figure 2.53 Circuit Schematics of inverter simulation

We want to do DC sweep Mode simulation, so we setup the sweep setting with the
10! Setup Simulation tool and ¥ Solver Options tool, as shown in Figure 2.54, p. 52.
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Figure 2.54 simulation condition setting and solver Options setting

We click the ® Run Simulation tool to start the simulation. The monitoring and
analysis procedure is similar to that in the previous example. In the result spread-
sheet, we plot the columns Output Voltage andInput Voltage , using Input
Voltage as the x-variable. The waveform plot is shown in the Figure 2.55, p. 53.

52 Genius Device Simulator



Mix-Mode Simulation of Inverter IO Circuit Tutorials

Plot: Untitled*
21
15
2
-
S 1
o
S
>
0.5
o
R T T e B e e S
0 0.2 0.4 06 08 1 12 14
V(inyVv

Figure 2.55 Simulation result
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Scripting and Automation

When building the diode and MOSFET in the previous sections, we used tools

Drawing Device Outline, Assigning Material Regions, Placing Doping Profiles and Meshing,
etc. in the GUI, to draw the device structure step by step. If the structure is com-
plicated, this process will take some time to complete. It would be okay to do this
once, but if you are to build several MOSFET devices, identical in all respects but
different gate lengths, the repetion becomes a burden.

To set you free from the tedious work, Visual TCAD provides scripting functional-
ity in several modules, which, among other things, can generate the device struc-
ture automatically. More importantly, one does not have to write the scripts from
scratch. In the case of device drawing, after one drew a first device strucuture in
GUI, he can export the drawn structure to a script file. One then use this generated
script file as the template, and with minor modifications, run the script to generate
new device structures.

The scripting language in VisualTCAD is Python, which is a general purpose pro-
gramming language with many useful libraries and utilities. In this section, we
shall see some examples on scripting in a few modules of VisualTCAD.

Example 1: Curve Plotting

54

We creat a new X-Y Plot window, and in the menu choose Plot> Run Python script to
run the script plot.py located in the examples/VisualTCAD/script directory.
Curves are plotted in the window, as shown in Figure 2.56, p. 54 . This figure has
two group curves and the first group has two curves.

eeeeee

Figure 2.56 script build plot result

Let us look at the script file for details. In the following code segment, we first
insert a curve group at position O (first group), which may contain a set of curves.
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We then define two arrays of numbers, xData and yData. One observe that they
have the same number of items, and the corresponding items follow the relation
y = x2. The next two commands define some curve properties such as a color,
line style and symbol style, and assign a title to the curve. Finally, we insert the
curve to group 0, and at position O in the group. The two numerical arrays are
used as x- and y-coordinates of the curve.

## insert Group O
plot.insertCurveGroup (0, 'Group',"'")

# Curve O in Group O

xData = [0, »1, »2,2.5]

yData = [0, 1, 4, ]

properties = {'hasLine':1,'lineColor':'#f£0000',
'lineStyle':1, 'lineWidth':1, 'hasSymbol':0,
'symbolColor': '#000000', 'symbolStyle':1,
'symbolSize':6, 'symbolFilled':1}

title = 'y=x"2'
plot.insertCurve(0,0,xData,yData,title,properties)

The following two lines illustrates how to use the list constructing syntax of Python
to define two numerical arrays for plotting the function y = x.

xData = [i*pi/6 for i in xrange(13)]
yData = [sin(x) for x in xDatal
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Example 2: Spreadsheet

After creating a new Spreadsheet window, we choose in the menu Spreadsheet >
Run Script to run the spreadsheet . py script, the result is shown in Figure 2.57,
p. 56 .

;Exp\orar [ Startj Spreadsheet Tools !

Spreadsheet Tools Bx
HlEE NG

Column Name | Properties

B

SpreadSheet: spreadsheetl23

Klifk
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w
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@
w
w

Kifdk

abs{cals(1]+cols[] 10 5 P

@
@

[e]lol=]o[n]"
o Lt
w

1z 3 B

| =5 TR TR

Figure 2.57 script build spreadsheet result

Some explanation of the script follows. The function setColumnData is for
setting entries of a column using the data in a numerical array. In this example,
we define an array colData and assign it to column O.

# set column data
colData = [1,2,3,4,5,6]
spreadsheet .setColumnData(0,colData) ;

One can apply mathematical expression (coded in Python) to the data of some
columes, and assign the result to a column. The following segment shows how to
calculate the absolute value of the sum of the first two columns, and assign it to
the 3rd column in the spreadsheet.

# calc Column
spreadsheet.calcColumn(2, "abs(cols[1]+cols[2])");

One can get and set title of columns with the getColumnName and setColumnName
functions, and save the spreadsheet to a file using the saveToFile function.
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Example 3: Building MOSFET Device Structure

After creating a new device 2d window, we choose in the menu Device B> Run Python Script
to run the script file named mosfet.py. A MOSFET structure is created by the
script, as shown in Figure 2.58, p. 57.

Figure 2.58 script build the MOSFET device structrure

The first section of the script consists of commands to draw outlines of the device.
As an example, in the following segment, we define a polygon with the coordinates
of its corner points. Note that the last point coincide with the first, so that it forms
a closed polygon. Then we add the polygon the the device structure using the
function addPolyLineItem:

# PolyLinelItem (#0)
pointS=( ,),( ,)3( P ),( P ),( ,)
device2d.addPolyLineItem(points)

The second section defines the material regions of the device. As shown below,
each region must have a label and a material name. A point in the region (pos) is
used to identify among the many regions in the structure. Optionally, one can set
mesh area constraint and assign a color. Finally, the region label is added to the
device with the function addRegionLabelItem.
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# RegionLabelltem 'Gate' (#44)

label = 'Gate'

material = 'NPolySi'

pos = ( s . )

areaConstrain =

color = '#cc71585"'

device2d.addRegionLabelItem(label ,material,pos,
areaConstrain,color)

The next section of the code defines mesh-size-control items. We wish to divide
the segment (-80,60)-(80,60) by at least 8 mesh grids. We add this constraint with
the addMeshSizeCtrlItem function, as shown below.

# MeshSizeCtrlItem (#116)

division =

points = (-80,60),(80,60)
device2d.addMeshSizeCtrlItem(division,points)

One important step is to set the doping profiles in the device. In the following
lines, we define the source LDD doping profile, which has a gaussian distribution
function. The profile attributes such as baseline, depth, normal direction, charac-
teristic lengths, xy ratio, label of the profile, peak doping concentration, doping
type, and doping species, must be set. The doping profile is then added with the
function addDopingProfileItem.

# DopingProfileItem 'LDD_S' (#134)
attributes = {'label':'LDD_S','type':'Gauss',
'property':'Nd’',

'n.peak':2e+19, 'polarity': 5
'baseline center':( ,0),
'baseline_length': g

"depth': , 'unit_normal':(0,1),
'xy.ratio': ,'y.char': }

device2d.addDopingProfileItem(attributes)

We can save the completed device structure to file. A mesh is needed for simula-
tion, and the doMesh function is invoked for this purpose. Finally, we export the
mesh in the TIF format so that it can be used in simulations.
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## save to file
device2d.saveToFile('/home/user/example/mosfet.drw');

## do mesh
device2d.doMesh()

## export mesh
device2d.exportMesh('/home/user/example/mosfet.tif');
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Example 4: Using More Than One Window:

60

After simulating the MOSFET constructed in the last section, we can plot the
Id-Vg curves use script file. An example script for this is provided (p18. py), and
the result is shown in Figure 2.59, p. 60.

c
\
\
\
i

i
N

Drain Current (A/um)

5e.05 |

1
Gate Voltage (V)

Figure 2.59 script build Id-Vg curve plot result

This involves two modules in VisualTCAD, spreadsheet and plotting, and the
script must operate at the global scope, using the mainwindow object mw. We
open this script file in VisualTCAD’s text editor, and run it with the menu item
Tools > Run as Python Script.

The script first opens the simulated IV datap18/result.dat and p18vd2/result.dat
in two spreadsheet windows, using the openDocumentFromFile function. User

will need to modify the path to the data filename. Then it creates a new plotting
window.

# open spreadsheet file
file = '/home/user/p18/result.dat’
mw.openDocumentFromFile(file)

# open spreadsheet file
file = '/home/user/p18vd2/result.dat’

mw . openDocumentFromFile(file)

plotA = mw.newWindow("Plot","plot2")

The windows are numbered, we obtain the spreadsheet with the getWindowByNumber
function, and read data from it. The curve is then added to the plotting window,
as we have done in the first example.

Genius Device Simulator



Scripting and Automation

Genius Device Simulator

Tutorials

# insert Curve 1 in Group O

spreadsheet = mw.getWindowByNumber (2) ;
Xdata = spreadsheet.getColumnData(3)
Ydata = spreadsheet.getColumnData(2)

properties = {'hasLine':1,'lineColor':'#f£0000',
'lineStyle':1, 'lineWidth':1,'hasSymbol':1,
'symbolColor':'#ff00ff', 'symbolStyle':O0,
'symbolSize':6, 'symbolFilled':1}

title = 'vds=0.2V'
plotA.insertCurve(0,!,Xdata,Ydata,title,properties)

One can use scripts to operate on more windows to automate TCAD simulation
and data analysis, as in the testMainWindow. py script, and the result is shown
in Figure 2.60, p. 61.

Figure 2.60 script build testMainWindow result
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With these examples we illustrated how one can use scripting for generating the de-
vice structure, plotting the 2D curves and manipulating spreadsheets, etc. Through

scripting, one can save much time and increase the efficiency of TCAD simulation
and analysis.
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Device Drawing

Structure Drawing

Menu

Adding Geometry ltem

Add Point
Add Polyline
Add Rectangle

Add Arc
Add Circle
Add Spline

Icon

o

nan

Description

Add a point item to the drawing.
Add a polyline item to the drawing.

Add arectangle item to the drawing, which will be converted to a closed polyline
item.

Add a circle arc item to the drawing.
Add a circle item to the drawing.
Add a spline item to the drawing.

Labeling Device Region and Boundary

Add Region Label
Add Boundary Label

Selecting Objects

Select Object

Select Point

General Editing Operations
Edit Properties

Make a Clone

Mirror Horizontally

Mirror Vertically

Move points

Genius Device Simulator

h & &

Add a material region label to the device structure.

Add a boundary label to the device structure.

Select a graph item (polyline, rectangle, arc, etc.), a label or a mesh-size-con-
straint item. This also switches to the solid editing mode for moving objects.

Select a vertex point. This also switches to the rubber-band editing mode for
moving vertices.

Edit properties (e.g. coordinates of polygon vertices) of the current drawing
item.

Make a copy of the selected drawing items.
Flip the current drawing item in the horizontal direction.
Flip the current drawing item in the vertical direction.

Enter the corner point editing mode. User can select a vertex in the highlighted
polygon and move the vertex.
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Device Drawing

Menu Icon Description

Snhap

Auto Snap *x Enter the automatic snapping mode. Mouse coordinates are snapped to a nearby
grid point or a vertex in existing drawing.

Grid Snap i Enter the grid snapping mode. Mouse coordinates are snapped to a nearby grid
point.

Line Snap A Enter the line snapping mode. Mouse coordinates are snapped to a point on a
nearby line segment.

Horizontal Line Snap ¥ Enter the horizontal line snapping mode. Mouse coordinates are snapped to a
point on a nearby line, the line segment currently being drawn is kept horizontal.

Vertical Line Snap & Enter the horizontal line snapping mode. Mouse coordinates are snapped to a
point on a nearby line, the line segment currently being drawn is kept vertical.

No Snap + Enter the free-hand drawing mode. No snapping of coordinates is applied.

Polygon

Properties Dialog

7+ VisualTCAD.LINUX

Corner points:

x |y |
1i-0.14 0.06 1
2(-0.14 1.4211e-17
; -0.12 1.4211e-17
: -0.08 0.06
5-0.14 0.06 D

& oK ‘7x Cancel i

Figure 3.1 Polygon Property Editing Dialog.

# Description

if neccessary, divide the dialog items into a few categories.

x- and y-coordinates of the first corner point of the polygon

2 Coordinates of the last corner point of a polygon must coincide with the first corner.

Add Region Label
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7~ Placing Region Label O X

~Basic Parameters

Region Label 1]
Material |

Symbol Color D m:
Max. mesh size (um) 0.1 4]

¢ S] Doping Species

Doping Species ﬂ

Concentration (cm~-3)  [le+16 ]
~Mole Fraction

[x= ] [y= J

| @ok || X cancel |

Figure 3.2 Add Region Label.

*H*

Description

Inputs the name of the region label, each region has one name, it can not be reused
Selects the material for the region from genius material library, more than 50 choices
Selects the symbol color for the region

Sets the maxmum mesh size for the region material

Selects the doping species, it can introduce uniform doping profile for the region

wn AW N =

Add Boundary

Label
Boundary Label | 1]
Symbol Color [i] g;_
. @oK | | X Cancel |
Figure 3.3 Add Boundary Label.
# Description
Inputs the boundary label name, its properties can be set in boudary command
2 Selects the symbol color for the boundary

Edit properties
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Description

Device Drawing

x- and y-coordinates of the first corner point of the polygon, double click to change the coordinate

value.

Coordinates of the last corner point of a polygon must coincide with the first corner.

#4 VisualTCAD.LINUX o (X
Corner points:
T [——
1:-014 0.06 1
2|-0.14 1.4211e-17
5]-0.12 14211617
(4]-0.08 0.06
5014 0.06 P
[ ¢ ok ] [ X Cancel ]

Figure 3.4 Edit properties.
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Device and Simulation

Menu

Icon Description

Profiles and Mesh Settings

Add Doping Profile
Add Mole Fraction Profile

Set Mesh Size Constraint
Meshing

Do Mesh

Refine Existing Mesh
Mesh Quality Statistics
Mesh 3D View

Delete Existing Mesh
Input/Output
Save Mesh to File

Run Python Script
Export Python Script

Add Doping Profile

Uniform
Doping Profile
#

AW N =

Gaussian
Doping Profile

Genius Device Simulator

& Add a impurity doping (donor or acceptor) profile to the device.

Bk Add a mole fraction profile for the compound semiconductor material in the
device.

i Add a mesh size contraint item to the device.

i Generate a mesh for the device.

i3S Refine the existing mesh.
Show statistics on the mesh quality.
Show 3D visualization of the mesh and doping profile.

i Destroy the existing mesh grid.

= Save the generated mesh to a file in TIF format.

Run a device drawing Python script.

Export the procedures to draw the present device as a Python script.

Visual TCAD provide total 4 kinds of doping profiles recently, including Uniform
Doping Profile, Gaussian Doping Profile, Erf Doping Profile and Dataset Doping
Profile etc.

Uniform Doping Profile
Gaussian Doping Prq{ile
Erf Doping Profile
Dataset Doping Profile

Figure 3.5 Doping Profile Type.

Description

Inputs Doping Profile name
Chooses Doping Species: Donor or Acceptor
Inputs Concentration of the Uniform Doping Profile

Uniform Doping Profile, in the bound region the doping profile is uniform distribution and out
of the bound region has none doping distribution
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# Description

1 Inputs Doping Profile name

2 Chooses Doping Species: Donor or Acceptor

3 Inputs Concentration of Doping Profile, two styles to choose: concentration peak or Total Dose.
4 Characteristic Length, two styles to choose: Y Characteristic Length or Doping Concentration

at depth, the Distance to doping Box parameter is a relative depth to the edge of bound rec-
tangle. The doping setting has 4 groups total, but the combination of Total Dose and Doping
Concentration is invalid.

5 Sets XY Ratio, the value is equal to X.char/Y.char

Gaussian Doping Profile, in the bound region the doping profile is uniform distribution and out
of the bound region the doping profile is gaussian distribution

#~ Place Uniform Doping Profile (m 4
~Basic Parameters
Profile Name [ 1 ]
Doping Species E
Concentration (cm~-3) | 1e+16 3)
~Profile Bound Rectangle 4
Baseline Point 1 ( [-0.3 J , [-0.2 ] )
Baseline Point 2 (|01 ].[-02 |
Height (um)
Orientation () Left @ Right
[ & ok I { X Cancel |

Figure 3.6 Uniform Doping Profile.
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Erf Doping Profile

AN N AW =
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#4 Place Gaussian Doping Profile O
~Basic Parameters
Profile Name | 11
Doping Species Donor |~ |7
@ Peak Concentration (cm~-3) |le+16 il
O Total Dose (cm™-2) [1e+13 g |
—Characteristic Length
@ Y Characteristic Length (um) [0.1 4 |
() Concentration by Distance to Doping Box
Distance to Doping Box (um) [0 2 ]
Concentration (cm~™-3) Ile+16 ]
XY Ratio (=X char/Y.char) [1 5 |
~Profile Bound Rectangle 5
Baseline Point 1 ([-027 ].[012 1
Baseline Point 2 (|012 |.|012 |
Height (um)
Orientation () Left @ Right
[ & oK I [ X Cancel ]

Figure 3.7 Gaussian Doping Profile.

Description

Inputs Doping Profile name

Chooses Doping Species: Donor or Acceptor
Refers to Gaussian doping Profile

Refers to Gaussian doping Profile

Refers to Gaussian doping Profile

Erf Doping Profile, in the bound region the doping profile is uniform distribution and out of the

bound region the doping profile is erf distribution
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Dataset
Doping Profile

Dataset
Doping Profile

#~ Place Erf Doping Profile

Device Drawing

~Basic Parameters

Profile Name |

Doping Species Donor 2

@ Peak Concentration (cm~-3) |le+16

O Total Dose (cm~-2) [1e+13

—Characteristic Length

@ Y Characteristic Length (um) [OAl

() Concentration by Distance to Doping Box

Distance to Doping Box (um) IO 2

Concentration (cm™-3) [1e+16

XY Ratio (=X.char/Y.char) [1

~Profile Bound Rectangle

Baseline Point 1 ([-0.27 ].[0a2 J‘:‘-T)
Baseline Point 2 (|012 |.|012 1)
Height (um)
Orientation O Left @ Right

| @ox || X cancel |

Figure 3.8 Erf Doping Profile.

Chooses profile dataset style, total 3 kinds of dataset doping: only 1D, only 2D

and Both.

Description

Inputs Doping Profile name

Chooses Doping Species, Donor or Acceptor

About only 1D option, importing the one-dimension doping data, it incuding 2 columns, first
column is coordinate and its unit is $\nMeter$, the second column is doping concentration and
its unit is $\ICubic\cMeter$. the doping data can come from the opened data file or look for the
data file by the data path.

When VisualTCAD introduces the data from the data file, VisualTCAD needs interpolation the
mesh point data, the default linear interpolation, here provides the logarithmic interpolation,

also.

In the bound rectangle region introduces one-dimension dataset file, the baseline from pointl1 to
point2 is the begin of the one-dimention doping data,the end of doping profile is expanded to
the edge of the box, out of the bound region has none doping distribution.
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# Description

1 About only 2D option, importing the two-dimension doping data, it incuding 3 columns, first
column is x-coordinate and its unit is $\nMeter$, the second column is y-coordinate and its unit
is $\nMeter$, the third column is doping concentration and its unit is $\[Cubic\cMeter$. the
value of the rectangle has been changed to 0, it means only the baseline from point 1 to point
2 is significative, VisualTCAD makes the center of the baseline as the 2D doping origin, the
doping data file introduces the two-dimension doping profile from the center of the baseline to
the doping coordinate of the doping file, the x-coordinate positive direction is left direction.

#= Place Dataset Doping Profile (i <

Profile Name | 1]

Doping Species | Donor 2

-~ Profile Dataset

[ only10 | only2D | Both | 3

g This profile only have 1D dataset

Datasetl | \;] I;]

¢l Logarithmic Interpolation

~ Profile Bound Rectangle

Baseline Point 1 ( [-013 |is 1-02 o
Baseline Point 2 (|01 ].[-02 )
Height (um) 01
Orientation O Left @ Right

[ & oK l { X Cancel ]

Figure 3.9 1D Dataset Doping Profile.

Dataset
Doping Profile
# Description
1 About Both option, in the bound rectangle region the doping profile is as the same as only 1D

option and the doping data from 1D data, out of the bound rectangle region the doping profile is
as the only 2D option doping profile and the origin is the the box baseline point2, and the left 2D
doping of the box is symmetric with the right of the box. in the bound region is significant only
for one-dimension doping data, out of the bound rectangle, the point 1 and point 2 is significant
for two-dimension doping data.

Place mole Ifthe device includes the polycompound material, Visual TCAD introduces 2 meth-
Fraction Profile ods to place the mole fraction of the compound, linear fraction and gaussian frac-
tion.

Linear mole
Fraction Profile
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Gaussian mole
Fraction Profile

Description

Inputs the linear mole fraction profile name
Inputs the range of mole fraction profile

Device Drawing

The linear mole fraction profile is introduced to the bound rectangle region from the baseline to

the end of the bound rectangle

=~ Place Dataset Doping Profile 0o x
Profile Name | |
Doping Species
~Profile Dataset

This profile only have 2D dataset

Dataset [

@) (&

[ Logarithmic Interpolation

~Profile Bound Rectangle

Baseline Point 1 (|-03

Baseline Point 2 (o1

Height (um)
Orientation () Left @ Right

| @ox || X cancel |

Figure 3.10 2D Dataset Doping Profile.

Description

Inputs the gaussian mole fraction profile name

Inputs the parameter of the gaussian mole fraction, including the peak, characteristic length and

ratio.

Gaussian mole fraction Profile, in the bound region the doping profile is uniform mole fraction
and out of the bound region the mole fraction profile is gaussian distribution.
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#= Place Linear Mole Fraction Profile O X
Profile Name | 1.0
~Linear Mole Fraction Parameters
~Rang of mole fraction X 2
Mole fraction from |o |
Mole fraction to [o |
-|_| Rang of mole fraction Y
Mole fraction from I ]
Mole fraction to [ J
~Profile Bound Rectangle 3
Baseline Point 1 (|-02 |.[-04 B
Baseline Point 2 (|02 |.[-0.4 1)
Height (um)
Orientation () Left @ Right

[ & oK ] IXCancel]

Figure 3.12 Linear Mole Fraction Profile.
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r~ Place Gaussian Mole Fraction Profile o X
Profile Name ] 1]
~Characteristic Length
~Char length of mole X 5
Peak |0 |
Y Characteristic Length (um) [0.1 ]
XY Ratio (=X.char/Y.char) |1 J
-] Char length of mole Y
Peak [ ]
Y Characteristic Length (um) [ ]

XY Ratio (=X.char/Y.char) ( )
~Profile Bound Rectangle 3
Baseline Point 1 (|-02 |.[-04 13
Baseline Point 2 ( [02 | . [-04 |

Height (um)
Orientation () Left @ Right
[ @ ok ] [X Cancel ]

Figure 3.13 Gaussian Mole Fraction Profile.
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7+ Place Dataset Doping Profile 0o X
profile Name | |
Doping Species
~Profile Dataset

Only 1D | Only 20 | Both | 1

4 This profile have 1D & 2D dataset

1D Dataset[ ]
2D Dataset | ]

["] Logarithmic Interpolation

~Profile Bound Rectangle

Baseline Point 1 ([-03 ].[-0.2 ]}
Baseline Point 2 (|01 |.[-0:2 1)
Height (um)
Orientation () Left @ Right

[ & oK l [XCanceI]

Figure 3.11 Both 1D&2D Dataset Doping Profile.

Do mesh
7+ VisualTCAD.LINUX g %
- fesh Qualty Control 1
Minimum triangle angle fast ‘I=O=’ best
- [] Mesh Refinement Control
Maximum doping difference fine = O ., Coarse
[%] measure as signed-log: sign(x)*log(1+[x|)
[ & oK ] [x_Canceil
Figure 3.14 do mesh.
# Description
1 The minimum angle constraint of the triangle mesh is from 15 to 32 degree, the triangle angle
is wider the mesh quality is better, but at the same time the rate of generating mesh is become
slow

Genius Device Simulator 75



GUI Reference

76

Refine

Mesh Statistics

Description

7+ VisualTCAD.LINUX

Device Drawing

- % {Mesh Quality Control:

Minimum triangle angle

fast ‘I=O=" best

¢ @ Mesh Refinement Control

4 measure as signed-log: sign(x)*log(1+|x]|)

Maximum doping difference fine =O=. W coarse D

[ ¢ oK ] IXCanceI]

Figure 3.15 refine.

Description

Calculates the doping Gradient and Specifies the refinement is based on the specified quantity

logarithm.

Refinement the mesh in doping Gradient greater than or equal to an order of magnitude, here

the range of doping Gradient is from 1 to 5.

#~ VisualTCAD.LINUX X

Mesh Statiastics
Point Number : 2145
Triangle HNumber: 4096
Mesh Size Statistics
Mesh Quality Statistics

Hin angle: 45 Hax angle: 90

Triangle angle histogram:

0-10 0 | 90-100
10-20 0 | 100-110
20-30 0 | 110-120
30-40 0 | 120-130
40-50 8192 | 130-140
50-60 0 | 140-150
60-70 0 | 150-160
70-80 0 | 160-170
80-90 4096 | 170-180

2

Min area: 1.953E-03um’2 Max area: 1.953E-03um’2

(=2 =T =T = I = = = = Y =

Figure 3.16 mesh statistics
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# Description
1 Statsitics the mesh point number, triangle number, mesh size and mesh quality etc.
2 Statistics the disposition of the triangle angle

Mesh 3D view

® VisualTCAD.LINUX

Figure 3.17 Mesh 3D view.

# Description

1 User can rotate the structure in the windows and view in any visual angle

Save mesh file to

Look in: [E3 /home/jidm/p18 Heooam®

& Computer

9 jidm

File name:  [p1g] 2 ] | kd save

Files of type: | TIF file (*tif) ~| | X cancel

Figure 3.18 Save Mesh File To.
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# Description
Chooses the file’s saving path
2 Inputs the file name and save the mesh structure file
Run python
Look in: Ihomeﬂidmlpython 1[’] QOO0 ®A B
\’ examples | || procDopDatpy
7 jidm
E home

File name: | 2 ] | s Qpen

Files of type: | Python Script Files (*.py ) |+] | X cancel

% |

Figure 3.19 run python.

# Description

Chooses the exist python file’s path
2 Selects the python file and open it

Export python

Look in: Ihomeliidmlpython f”,] Q0 0R ®
\’; examples | procDopDat.py

B jidm

9 home

File name: | 20 ] | kd save

Files of type: | Python Script Files (*py ) |+] | X cancel

% |

Figure 3.20 Export python.
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# Description
1 Chooses the file’s saving path
2 Inputs the file’s name and saves the python deck file
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Menu

Device View

Fit to View

Center Origin Point
Zoom In

Zoom Out

Ruler

Icon

L P HE

Device Drawing

Description

Center the device drawing, and scale it to fit the screen size.
Center the screen at the origin of the device coordinates.
Zoom in, with the point under the mouse cursor fixed in view.
Zoom out, with the point under the mouse cursor fixed in view.

Add a ruler item for measure the linear distance between two points.
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Device Simulation

Simulation Setting

Menu

simulation setting

Load
Resistive Metal
Run

Write Deck File

Solve

Time Control
Sweep Control
Boundary Condition

Physical Model

Solver Options

Output

Show IV Data

Show Visualization

Load

Genius Device Simulator

Icon

G

£ s [

Q E

Description

Description

Open a structure file.
Turn on the resistive metal model (new in 1.7.1).
Running the device simulation.

Save the device simulation configuration to a directory, which will contain the
command file (.inp) and mesh file (.cgns) and data files (if needed).

Time parameters in Transient simulation.

DC sweep parameters in DC Steady-state simulation.
Boundary and Contact settings of the device.
Physical Model and Material Model parameters.

Numerical solver paramters, including Number of Processors in parallel simu-
lation.

Open the IV data file.

Open the . vtu file to visualize the internal variables (potential and carrier con-
centrations, etc.) in the device.

Chooses the exist structure file’s path

Selects the structure file and open it
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Resistive Metal

Device Simulation

¥ Choose the structure file =%
Look in: [E4 home/jidm/python T~ O AlE
2 examples
= jidm
= home

File name: ||

o ] Open

~| | X cancel

Files of type: | Structure files (*.tif *.cgns *.grd *.tif3d)

Figure 3.21 load structure file.

When the device exist the boundary of the metal, user should be set it to "Soder

pad" Boundary and open the "Resistive Metal" button before load the device struc-
ture in the "Device Simulation" window.

Visual TCAD - [Device 20: untitled"] (on hydrogen.localdamain)

MR OBl Zol Vew  Tawng Dewer Miwow o Help —[EIE
= | & 2, .
O-El D¢ (| @ H 2 0D | e
Cxplerer | Stet | Pevie Trwng
Lav e lsamry &)

baundary
IRy

a oA
s EIHO 82

boundary

\JDLIHJLI‘,( tool
@l @ a

A WA

Enllas RS

B T
Objeet List b

—

3auncary labal e Aroce’ (..
- 3rancary bbel e ©attaee |
A " [ i#21)

n silicoy (w2n )

- 3egion lazel
rrofile izens
wash-rante irems

= An ol il

MoLse. [-0.1:80,-0.08241 SaZa. -UIbEE U i)

Figure 3.22 define boundary.
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# Description
1 Choose boundary tool
2 Add boundary label(Anode and Cathode)

Boundaries and Contacts

Electrical | Thermal ]

Boundary Type
bound:
Anode Neumnann boundan Type ‘ uneery. hd ‘
Cathode Neumann boun
E:-\\ Boundaries anﬁ\ Electrical | Thermal
T H"’{\\ Boundary ‘M! Type | Solder pad -
\\Y N, Anode Ohmic contact B -
L— oldsr pad elo o _I7]
capaciance[s ]
e C—1
[ Overide Global Z Width

r% .
‘ Interconnect << Less 'LM""‘

Boundary Z Width |um =]
|

Interconnect << Less More ==
Restore Defaults X Cancel

Figure 3.23 change boundary setting.

# Description

1 In "Device Simulation" window, load the mesh, and click "Boundary Settings"
2 Click "More>>" to see the full list

3

Change from "Neumann" to "Ohmic" and "Solder pad" boundary conditions, respectively.

Run simulation

3 submitting simulation job X

i‘ You need to save the simulation settings before running it.
Do you want to save it now?

aa B 1

Figure 3.24 run simulation.

# Description

When user runs the simulation, VisualTCAD will remind user to save the simulation settings
before running it

write deck file

Genius Device Simulator 83



GUI Reference Device Simulation

# Description

1 User can transform the simulation to genius deck file and run the deck file in Genius to finish
the simulation.

i Exporting simulation job

"=y You need to save the simulation settings before exporting it.

4

A Do you want to save it now?
(O] [ @w ] |
Figure 3.25 write deck file.
Time Control
3 VisualTCAD.LINUX O X

~Time Steps ‘I

Start Time | s |~

Step Time |0 | B [~

Stop Time |0 | [s lv]

l -]

Max. Step Time |0

~ Options
Max. voltage step (Vv): @ Default: not limited 2
ol e
Predict next solution:
Auto-adjust time step:

[ ¢ ok l [XCanceI]
Figure 3.26 time control.
# Description
1 For transient simulation, the time control setting needs set start time, step time, stop time and
Maxmum step time etc.
2 Other options, user can choose to set maxmum voltage step

Boundary condition
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physical model

Genius Device Simulator

GUI Reference

Description

Clicks to choose the boundary

Chooses the contact type, total includes many types, here chooses the ohmic contact

Sets ohmic contact parameters, some contact have no parameters, such as Neumann boundary.
Sets boundary z width, the priority is higer than global z width setting.

¥ VisualTCAD.LINUX %
Boundaries and Contacts Electrical | Thermal |
Boundary =
. T
Ohmic contact Lz LOhmlc contact 14
Gate Gate contact Resistance [o ] [Q I-]
Source Ohmic contact
Substrate Ohmic contact Capacitance [D ] [F |'] 3
Inductance [0 1[H [+

[_] override Global Z Width

e I R >_}> Boundary Z Width [1 ] [am [4

Restore Defaults X Cancel

Figure 3.27 Boundary condition.

¥ VisualTCAD.LINUX

i|_Physical Models | Material Models |
External Temperature [300 ] K \v]
Z width [1 | [um [+]
Physical Equau’ons[Basic Drift-diffusion ‘v] 2
L3

Restore Defaults

Figure 3.28 Global model.
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Device Simulation

Description

Sets global parameter, temperature and z width parameters

Chooses the physical equations, including Basic Drift-diffusion equations, Drift-diffusion equa-
tions with lattice heating and Energy-balanced drift-diffusion equations. Here chooses Basic
Drift-diffusion equations

¥ VisualTCAD.LINUX o %

[ Global Parameters | Physical Models [ Material Models |

| Region |Material | Type | FioREes [
Drain Al Electrode region Carrier Statistics | Boltzmann ||

Gate NPolySi  Electrode region e

Source Al Electrode region Energy balance eqn. | None }v‘
Substrate Al Electrode region = o

oxide Si02 Insulator region

spcl Nitride  Insulator region

spc2 Nitride _Insulator region >

substrate Si Semiconductor regioh (% High-field mobility 3

Transverse E-field

Longitudinal E-field | Simple E field | v |

[ Impact lonization - - 4
Il driving force [af Gradient xil
_| Band-to-band tunneling 5

| Carrier trapping

| Restore Defaults \ ‘VX Cancel i

Figure 3.29 physical model.

Description

Sets physical model of silicon material and other materials choosing the default model

Carrier statistics, chooses Boltzmann distribution or Fermi-Dirac distribution. Energy balance
equaption, When the Energy-Balance equation solver is selected in the METHOD command, this
parameter selectively enables the equations for lattice temperature, electron temperature and
hole temperature.

Transverse E-Field, Use effective surface electric field for carrier mobility calculation at insu-
lator-semiconductor interface. Longitudinal, Synonym to Mobility.Force. When H.Mob is
enabled, this parameter selects the driving field used in high-field mobility calculation.

When ImpactIonization is enabled, this parameter selects the driving field used in impact
ionization coefficient calculation. including Qf Gradient, E dot J, E along mesh-edge and simple
E field.

Activates the Band-to-Band Tunneling (BBT) generation, and selects whether the BBT genera-
tion should be calculated with the local model or the non-local model. Only the local model is
currently implemented. Whether the Carrier trapping is enables
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# Description

Sets material model of silicon material and other materials choosing the default model
Basic model, including Default model only

3 Basic model, user can modify the parameter of the model by clicking the right button Add Prop-
erty and input the paramenter Name and Value. User can inputs print as the parameter Name
and 1 as the Value, then runs the simulation, all parameters setting of the selected model are
printed in Log file.

4 Other Material model, using the same method, user can modify other model by modifying the
model parameters, the model including Band, Impact, Mobility, Optical, Thermal and Trap.

2 VisualTCAD.LINUX O X
| Global Parameters | Physical Models | Material Models

Region IMateria! |Type Basic
Drain Al Electrode regio|
Gate NPolySi  Electrode regio| Model ﬂ 2
Source Al Electrode regio|
Substrate Al Electrode regio| Parameters | Name Value a4
oxide Si02 Insulator region =
spcl Nitride  Insulator region| ]
spc2 Nitride _Insulator region
substrate S Semiconductor ﬁ

Band

N
Impact N
Mobility ¢
Optical “
Thermal RO
< [«]») Trap Nl

X el

Figure 3.30 material model.

Solver Options

¥ VisualTCAD.LINUX affls

~Non-Linear Solver Options

Number of Processors 1
Maximum iterations 2

Update damping [Potenﬁa! damping Iv]
Potential damping factor 3

~Misc. Options

Truncate voronoi cell | Always truncate (4

Linear solver type [Direct (MUMPS) Iﬁl
[,

Restore Defaults ] [ @ oK ] [x Cancel]

Figure 3.31 Solver options.
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Device Simulation

Description

Chooses the number of processor of simulation

Chooses the maxmum iterations, the default setting is 30

Chooses whether using update damping and sets potential damping factor

Selects the element truncation strategy used in simulation, including Always truncate, Never
truncate and truncate at boundary.

Selects the linear solver algorithm, including Direct(MUMPS), Direct(SuperLU), iterative(BCGS+ASM)
and iterative(BCGS+ILU).
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GUI Reference

Circuit Schematics

Place Circuit Component

Menu Icon

device setting

Component 3~
ta

Numerical Device

Common Circuit Components

Ground =
Resistor i
Capacitance =
Inductance ?
Probe
Voltage Probe
Current Probe
Connection
Wire T

Component

# Description

Description

Add a Spice component (compact model) to the circuit.

Add a numerical device to the circuit, for mix-mode simulation.

GND.
Add a resistor component.
Add a capacitor component.

Add an inductor component.

Add a voltage probe to the circuit, for monitoring voltage difference between

two circuit nodes.

Add a current probe to the circuit, for monitoring current through a circuit

branch.

Add wirings to the circuit.

According to user need to select component

Simple description of the component

3 Component preview window

Genius Device Simulator
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[ Place component

~Component Selection

Circuit Schematics

o x

~Component Description

(74HC(T) T

Library: T4HC(T)
C TAHCO4

74HC04
74HC08

T4HCO4

~Component Preview

X?

74HCO04

Ubrary Manager

Figure 3.32 Component.

Numerical Device

™ Load Device

= &3 X

Look in: lhomeﬂidmlple

Hlecooada@mm®

™| Computer

7 jidm

" pl8sim

File name: ||

Tl _l w Open

Files of type: | Sim Files (*.sim)

|~] | X cancel

% |

Figure 3.33 Numerical Device.

# Description
1 Load the device component file’s path
2 Selects the device component file and opens it
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Simulation Control

Menu Icon

Circuit simulation setting

Simulation Setup

Solver Options ‘H

Run Simulation L 3
Check Netlist
View Netlist

Write Deck Files

Setup Simulation

GUI Reference

Description

Choosing the analysis type and setting analysis parameters.

Numerical solver paramters, including Number of Processors in parallel simu-
lation.

Start the simulation.
Check the validity of the circuit netlist.
Viewing the netlist file (in SPICE format).

Save the circuit simulation to a direcotry, which contains the circuit netlist, Ge-
nius command file, mesh file and other data files (if needed).

[& analysis Settings o X
{ Analysis Type [ ﬁ___mEh
~Transient Settings
Stop Time: [ 0.0 | [s_[+) <
Time Step: | 0.0 | [s_I=)
Max Time Step: [0.0 s[5

["] Use Initial Conditions
Max. voltage step (v): @ Default: not limited
ot IV
Predict next solution: @
Auto-adjust time step: @

~Initial OP Analysis Options

Number of Source Ramp-up Steps _g 3
Max. Voltage Step in Ramp-up @ Default: not limited
o [0 N r—r

Initial Value of GMin Stepping @ Default: 1 uS
o | EE

Target of GMin Stepping @ Default: 1 ps
o [1 ) (s

Figure 3.34 Setup simulation transient analysis.
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Description

Circuit Schematics

Selects the analysis type, Here choosing transient simulation type

Sets the transient simulation condition

Initial operator point analysis options, including the number of ramp-up steps of the bigest
nonzero External Source by Attach statement, the maxmum voltage steps, initial value of Gmin
stepping and target of Gmin stepping. The perpose of the initial setting is making the simulation
more convergence.

[® Analysis Settings o X
{ Analysis Type Wﬁ J
~DC Sweep Settings

~Sweep Variable ~Sweep Range 3
Sweep Component: [ ]+
O Current source S| ) (=]
) Sweep End: [0.0 | vz
O Resitor Sweep Step: [0.0 v |+
—Options
Max. voltage step (V): @ Default: not limited
ofs ) (al=
Predict next solution: @
rInitial OP Analysis Options
Number of Source Ramp-up Steps E@
Max. Voltage Step in Ramp-up @ Default: not limited
O [o ] [-]
Initial Value of GMin Stepping @ Default: 1 uS
o [1 ) (s I
Target of GMin Stepping @ Default: 1 pS
O [1 ) eI
X cancel

Figure 3.35 Setup simulation DC sweep analysis.

Description

Selects the analysis type, here choosing DC Sweep simulation type

Selects the sweep variable

Selects the sweep component and sets the sweep range

Description

Selects the analysis type, here choosing AC Sweep simulation type

Selects the AC sweep step spacing linear or logarithmic and sets the sweep range
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Circuit Schematics

Check netlist

Genius Device Simulator

Description

Selects the analysis type, here choosing Operation Point simulation type

Here no settings are needed

[& Analysis Settings

{ Analysis Type [AC

~AC Sweep Settings

AC Sweep Step Spacing
AC Sweep Step: 0.0 |[Hz |+]
AC Sweep Start Frequency: I0,0 ] [Hz [v] 2
AC Sweep End Frequency: [ 0.0 |[Hz [+
r~Initial OP Analysis Options
Number of Source Ramp-up Steps [0 2]
Max. Voltage Step in Ramp-up @ Default: not limited
o B i —
Initial Value of GMin Stepping @ Default: 1 uS
o [x I TR B2
Target of GMin Stepping @ Default: 1 pS
o ) G

GUI Reference

Figure 3.36  Setup simulation AC sweep analysis.

Description

When user finishes the circuit schematic, user need check the netlist, when it is OK, user can

run the circuit simulation.
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View netlist

I“-\i—)l Check Netlist OK.

Figure 3.38 check netlist.

[& Analysis Settings

Circuit Schematics

iAnaIysisType Operation Point.

~Operation Point Settings

No settings are needed for this simulation

~Initial OP Analysis Options

Number of Source Ramp-up Steps [0 |2

Max. Voltage Step in Ramp-up ® Default: not limited

o [o

Initial Value of GMin Stepping @ Default: 1 us

O 1

Target of GMin Stepping @ Default: 1 pS

o |

o X
R —
R
) L

Figure 3.37 Setup simulation operation point analysis.

Description

According to the circuit schematic, VisualTCAD generates the netlist automatically,the netlist

file includes circuit components and wire connection etc.
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Genius Device Simulator

[® view Netlist a X

~SPICE Netlist

* circuit components

V2 V2Pos V2Neg 0.1V 1

VProbel ProbelPos Probellleg 0OV

V1 V1Pos Villeg 0V

R1 R1Pos RllNeg 1k

N1 M1PIN_S=Source N1PIN_G=Gate NI1PIN _D=Drain ]

|»

* wire connection (by OV VDC)
VMNET_000_ N1PIN_D R1lPos 0OV
VNET_001_ V2Neg 0 OV
VNET_002_ 0 NET_000 OV =
VNET_003_ 0 ViNeg 0V
VMNET_004_ NET_000 N1PIN_B 0V
VMNET_005_ NET_000 N1PIN_S OV
VNET_006_ Probellleg RlNeg OV

VNET_007_ V1Pos N1PIN_G 0V @

VNET_008_ V2Pos ProbelPos 0OV

] 10

Figure 3.39 View netlist.
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Result Analysis

Menu Icon

Simulation Results

Load Spice Raw File

= E

Plot Probe Wave

Circuit Schematics

Description

Open the simulated waveform in a spreadsheet window.
Plot the waveform of voltage and current probes.
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Schematics View
Menu Icon Description

Schematics View

Fit to View Move the schematics to center and scale it to the fit the screen size.
Center Origin Point as] Move the schematics to center.

Zoom In & Zoom in.

Zoom Out & Zoom out.
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Device Visualization

Device Visualization

View

98

Menu

General Options

Switch Background Color

Inverse Y of View Point
Camera Options

Reset View
View at +X
View at -X
View at +Y
View at -Y
View at +Z

View at -Z

Icon

RELEER B 4

Description

Toggle the screen background color between black and white.

Toggle the direction of the y-axis between up and down.

Reset camera position, orientation and focal parameters.

View the device from the direction of +x axis.

View the device from the direction of -x axis.

View the device from the direction of +y axis.

View the device from the direction of -y axis.

View the device from the direction of +z axis.

View the device from the direction of -z axis.
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Draw

Menu Icon Description

Device Drawing

Draw Device Region Plot the regions in the device structure.
Draw Device Material Plot the materials in the device structure.
Draw Device Boundary nd Plot the boundary and interfaces in the device structure.
Draw Mesh i) Plot the mesh elements in the device structure.
Device Variable Plotting
Draw Pseudo Color 4 Draw a pseudo color plot of the selected variable.
=

Draw Contour Draw a contour line (surface) plot of the selected variable.

LA
)1"\»*

Draw Vector Draw a vector plot of the selected variable.
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Animating the simulation result
Menu Icon Description

Animation Control

First Frame ® Show the first frame of the simulation results.
Previous Frame (] Show the previous frame.

Next Frame © Show the next frame.

Last Frame (1) Show the last frame.

Play/Pause () Play (or Pause) the animation.

Add Frames

Add Frame(s) Add frames (.vtu files) to the animation.
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GUI Reference

Spreadsheet

Menu

Spreedsheet Operation

Insert Row
Insert Column
Delete Row
Delete column
Plot Column

Calculator
Scripting

Run Python Script

Plot column

Icon Description

ot Insert one row in the spreadsheet.

= Insert one column in the spreadsheet.

261 Delete the selected rows in the spreadsheet.

| Delete the selected columns in the spreadsheet.

v Plot the data in selected columns.

Use mathematical calculator to calculate data entries in the selected column.

Run a spreadsheet Python script.

™ VisualTCAD.LINUX — =1

Please select the x-axis data columii
'5: vlpos [V] v

[ & oK ] }XCancelJ

Figure 3.40 plot column.

Calculator

Genius Device Simulator

Description

User need select at least two columns and set one column data as x-axis data column

Description

Visual TCAD offers calculate function, user can obtain the expression
The calculate data come from the column data.

The expression can include the function of VisualTCAD offers, including absolute value calcu-
late and square calculate etc.
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™ calculator

Please enter the expression for column 12. Valid operators are + - * /

=]

X

Columns: Functions:

cols[1]: 0 [V] abs(x)

cols[2]: v2pos [V] powix,e)

cols[3]: v2neg [V] sqrt(x)

cols[4]): rlpos [V] exp(x)

cols[5]: rineg [V] log(x) 2

cols[6]: vipos [V] logl0(x)

cols[7]: vineg [V] sin(x)

cols[8]: nlpin_s [V] cos(x)

cols[9]: nlpin_g [V] tan(x)

cols[10]: n1pin_d [V] asin(x)

cols[11]: nlpin_b [V] acos(x)

cols[12]: probelpos [V] atan(x) @
calcll 3 nrabalnas [V einhiv)

Expression:
[cols[1]+colsl2] 1 J

Spreadsheet

Figure 3.41 Calculator.
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GUI Reference

XY Plotting

Menu Icon Description

Plot Data Source

Insert Curve ke Insert curve in the current group.

Insert Group fol Insert group in the plot.

Delete i Delete the selected curve or group.

Edit Plot Properties

Edit Axis Properties 5 Edit the axis properties, e.g. the axis scale, range and tick marks.
Edit Curve Properties = Edit the curve properties, eg. the line style, symbol style and color.
Palette Manager Edit the plot curve style palletes.

Input/Output

Run Python Script Run a Python for curve plotting..

Export Python Script Export the current plot to a python script file.

Insert Curve

™ Select the x- and y-variables to plot with. o X
X Variable 1 Y Variables 2
Name Properties Name [Propen:ies |
{result.dat SpreadSheet result.dat SpreadSheet
rampl.dat SpreadSheet rampl.dat SpreadSheet

Figure 3.42 insert curve.

Genius Device Simulator
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# Description

1 User can insert several curve to one plot, the x- and y-variable come from the open any data file.

XY Plotting

the left window is for choosing the x-variable and only can choose one column data.

2 The right window is for choosing y-variables, user can choose several column data as y variables

at the same time.

Edit Axis Properties

™ Setting line/symbol styles.

Bottom x-axis
Right y-axis
Top x-axis

O

[%] Axis Enabled
i Tt
Axis Scale Type

(% Auto Scale

Min. Axis Value [:]
Max. Axis Value
Max. Major Divs.
Max. Minor Divs.

Figure 3.43 Edit Axis Properties.

# Description

User can edit the plot axis properties, inputs the left y-axis title

Selects the Axis Scale type, linear scale, logarithmic scale etc.

3 Inputs the range of value of the axis.

Edit Curve
properties

™ setting line/symbol styles.

Y-axis

104

1

- %] Line

Style | Solid line 2]+
color [Black___|+)
Thickness [0

0o X
-] Symbol
Style [Square Iv]
Coler
Size [6 ]
(%] Filled
[ ¢ oK I [XCancell

Figure 3.44 Edit Curve Properties.
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# Description
1 User can edit each curve properties and slect each line axis style
2 Selects each curve line and symbol style

Palette Manageer

™ Palette Manager m b4

Palettel
Palette2
Palette3 1
Palette4
Palette5
Palettef
Palette7

et lPBeces) (el

[ Restore Defaults ] [ L] Save I [-i Discard] [ X Close l

Figure 3.45 Palette Manager.

# Description

VisualTCAD offers 7 palettes for user
User can edit new palette
3 User can edit new curves of the selected palette and restore default palettes
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Text Editor

Text Editor

Search
Menu Icon Description
Find Search a string in the text.
Find Next Go to the next match in the text.
Find Previous Go to the previous match in the text.
Replace Replace the matched string.
Find
Find I 1 | | Find
=L e |
(% Match case
O wholiword only
[] Backward
["] Regular expression
Figure 3.46 Find.
# Description
1 Inputs the find text
2 Selects the properties
Replace
™ Replace = (=] B
Find (l 1 | | Replace
e @8 el

P2
(%] Match case

O Wholesword only
[ Backward

[ ] Regular expression

Figure 3.47 Replace.

106

Genius Device Simulator



Text Editor

Genius Device Simulator

Description

Inputs the find text
Inputs the replace text
Selects the properties

GUI Reference

107



GUI Reference Text Editor
Options

Menu Icon Description

Spreedsheet

Syntax HighLight Mode Highlight the text with the selected syntax mode, eg.Genius,Spice,Python, XML

or no-highlight.

Font Settings Font settings of the text window.

Font Settings

[ Select Font

Font

Font style Size

[Courie I

[Norrnal2 ] [10 3 ]

Bitstream Vera Sans Mono
Bitstream Vera Serif
Caladings CLM

Century Schoolbook L
Console
Coune:

Effects

|| Strikeout
[_] Underline

-

Writing System

[Any

6 -
Italic 7 E
Bold 8

9

Bold Italic

—Sample

AaBbYyZz

L

Figure 3.48 Font Settings.

# Description

Selects the font
Selects the font style
Selects the font size
Other effects

AW N =
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Tools
Menu Icon Description

Simulation Tools

Run As Genius Deck Run Genius device simulator with the curent file as the command input.
Run As SPICE Deck Run SPICE circuit simulator with the current file as the circuit deck.
Run As Python Script Run the text file as a Python Script.
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A

Programming Reference

Device2D Drawing

Class Device2DScript

The Device2DScript exposes APIs for device2d drawing in python language.

Method scriptType

scriptType()

Returns  Object name "device2dscript".

Method addPolyLineItem

addPolyLineItem(points)

Arguments points list, a list of points which to build a poly line. For example, points =
(-400,0), (400,0), (400,1000), (-400, 1000), addPolyLineltem(points) will draw
line((-400,0), (400,0)), line((400,0), (400,100)), line((400, 1000), (-400,1000)).

Method addRegionlLabelItem

addRegionLabelItem(label ,materail, pos, areaConstrain=0.01,
strColor="#ffb6cl")

Arguments 1label string, name of the region label item.
material string, name of material which used in region.
pos point, region item position.
areaConstrain double, set region mesh area constrain.
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strColor string, name of color which used in region.

Method addRegionDoping

addRegionDoping(label,property, concentration)

Arguments label string, name of the region.
property string, property of region,"Nd" or "Na".

concentration double, concentration of region.

Method addRegionMoleFraction

addRegionMoleFraction(label, x, y=-1.0)

Arguments label string, name of the region.
x double, x fraction.

y double, y fraction.

Method addDataset

addDataset (xList, yList, vList, dsName="")

Arguments xList list, list of x coordinate position.
yList list, list of y coordinate position.
vList list, list of value.
dsName string, name of dataset.

Returns dataset label for this dataset, which append SHA1 to dsName.

Method addDataset

addDataset (type, filename)

Arguments  type string, 1D or 2D dataset file.
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filename string, dataset file name.

Returns  dataset label for this dataset, which append SHA1 to filename.

Method addDopingProfileltem

addDopingProfileltem(attr)

Arguments attr list, a list of name and value pair for profile item.

Method addMoleFractionItem

addMoleFractionItem(attr)

Arguments attr list, a list of name and value pair for mole fraction item.

Method addBoundaryItem

addBoundaryItem(label, segment, strColor="#ff0000")

Arguments label string, label for boundary item.
segment list, point pl and p2 to decide item region.

strColor string, background color for item.

Method addMeshSizeCtrlItem

addMeshSizeCtrlItem(division, points)

Arguments division int, number of division.

points list, start point and end point to decide MeshSizeCtrlltem.

Method addRulerItem

addRulerItem(points)
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Arguments points list, start point and end point to decide RulerItem.

Method addPointItem

addPointItem(point)

Arguments point list, (x, y) to decide Pointltem.

Method doMesh

doMesh( optimization = 1, meshCmd = "pzADen(qg30", max_d=3.0,
signed_log=true)

Arguments optimization int, times to refine mesh.
meshCmd string, command to do mesh.
max_d double.

signed_log bool.

Method exportMesh

exportMesh( filename)

Arguments filename string, name of tif file when export mesh.

Method clear

clear()

Method saveToFile

saveToFile(filename)

Arguments filename string, filename to save file, which can be relative or absolute filename,
if relateive, save in current directory where program is running.

Method setTitle

setTitle( title)
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Arguments title string, title for Device2D SubWindow.
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Curve Plot

PlotScript

The PlotScript exposes APIs for curve ploting in python language.

Method scriptType

scriptType( )

Returns Return the object name "plotscript”.

Method curveGroupCount

curveGroupCount ( )

Returns Return the count of curve groups.

Method curveCountAt

curveCountAt ( group)

Arguments group int, group index.

Returns Return curve count at group group

Method insertCurveGroup

insertCurveGroup( pos, groupTitle="Group", groupPalette = QString())

Arguments pos int, index of curve group.
groupTitle string, title for this curve group.

groupPalette string, palette name for this curve group.

Method removeCurveGroup

removeCurveGroup( int pos)
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Arguments pos int, index of curve group which will be deleted .

Method setGroupTitle

setGroupTitle( group, title)

Arguments group int, index of curve group.

title string, title for curve group.

Method insertCurve

insertCurve( group, pos, xData, yData, title = "curve", properties
= QVariant())

Arguments group int, index of curve group.
pos int, index of curve in curve group.
xData list, data for x coordinate .
yData list, data for y coordinate.
title string, title for the curve.

properties list, a list of curve properties.

Method clear

clear()

Method saveToFile

saveToFile( filename)

Arguments filename string, save to file with filename.

Method setTitle

setTitle( title)

Arguments title string, title for plot subwindow.
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SpreadSheet

class SpreadSheetScript

The SpreadSheetScript class exposes APIs for spreadsheet operations in python
language.

Method scriptType

scriptType )

Returns Return the object name "ssheetscript".

Method getColumnName

getColumnName ( column)

Arguments  column int, index of column, index from O.

Returns Return the name of column.

Method getColumnData

getColumnData( column)

Arguments  column int, index of column, index from O.

Returns Return data in column.

Method insertRows

\GSyntax{insertRows}( row, count)

Arguments row int, row index where rows will be inserted.

count int, number of rows will be inserted.

Method insertColums

insertColums( column, count)
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Arguments  column int, column index where columns will be inserted.

count int, number of columns will be inserted.

Method setColumnData

setColumnData( column, data)

Arguments column int, index of column.

data list, assign data to column.

Method setColumnName

setColumnName ( column, name)

Arguments  column int, index of column.

name string, name for column.

Method calcColumn

calcColumn( column, expression)

Arguments column int, index of column.

expression string, expression to compute data for column.

Method saveToFile

saveToFile( filename)

Arguments filename string, save to file with filename.

Method setTitle

setTitle( title)
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Arguments setTitle string, title for spreadsheet subwindow.

Method clear

clear()
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MainWindow

Class MainWindowScript

The MainWindowScript class exposes APIs for operations in top level in python
language.

Method scriptType

scriptType()

Returns  Return the object name "mainwindowscript".

Method openDocumentFromFile

openDocumentFromFile( filename)

Arguments filename string, name of file which to open.

Method saveAllToFile

saveAllToFile( filepath)

Arguments filepath string, path to save content of all subwindow to file .

Method newWindow

newWindow( type, title)

Arguments type string, type of window, type can be "Device2D" "Plot" or "SpreadSheet".

title string, title for window.

Returns Return a pointer which point to created window, if failed, return
NULL.

Method getWindowByName

getWindowByName ( subWindowName)
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Arguments subWindowName string, name of subWindow.

Returns If find a subwindow which has name \GSyntax {subWindowName},
return a pointer which point to it, else return NULL.

Method getWindowByNumber

getWindowByNumber ( number)

Arguments number int, index of subwindow.

Returns If find a subwindow which has index \GSyntax {\GSyntax {number}},
return a pointer which point to it, else return NULL.
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